# Table Of Contents

## 1. Introduction
- Getting Started ................................................................. 1
- Where To Find Help ............................................................. 2
- Middle Button Menu Help .................................................... 2
- The ARRIS Web Training Center .......................................... 3
- How We Present Instructions ............................................... 4
- Typographical Conventions .................................................. 4
- Keyboard Conventions .......................................................... 4
- Mouse Conventions ............................................................. 4
- Instructional Terms ............................................................. 4

## 2. The ARRIS User Interface
- The ARRIS Menu System ..................................................... 5
- The ARRIS Main Menu / Windows Menu Bar ......................... 6
- The ARRIS Application Menu ............................................... 7
- The ARRIS Application Sub-menu ......................................... 8
- The ARRIS Status Menu ..................................................... 9
- The View Control Bar .......................................................... 10
- The User Toolbar ............................................................... 11
- The Prompt / Message Line .................................................. 12
- Point Coordinate Display ..................................................... 12
- The ARRIS Display Window ................................................ 13
- Select Entity ......................................................................... 13
- Pop-Up Menus .................................................................... 14

## 3. The ARRIS User Interface - Hardware
- The ARRIS User Interface - Hardware .................................. 15
- Function Keys ..................................................................... 16
- Graphic Interface (Menu) Mouse Button Selection ............... 18
- Display Window Mouse Button Selection ............................. 18
- Special Keys .................................................................... 19
- Mouse Gestures .................................................................. 20
- Mnemonics ........................................................................ 22

## 4. Important Concepts
- The XYZ Coordinate System ............................................... 23
- XY Forcing ........................................................................ 23
- Points ............................................................................... 24

## 5. Parameters
- Basic Methodology ............................................................. 25
- Create An Entity Styles Catalog ......................................... 25
- Create Line Parameter Styles .............................................. 25
Table Of Contents

6. Drawing In ARRIS .................................................................29
   The Line Select Menu..................................................................29
   Line Placement - Mouse Input ..................................................29
   Line Placement - Coordinate Entry .........................................32
   New Reference Point ...............................................................36
   Double Reference Point .........................................................37
   More Placement and Parameter Information ..........................39
   Drawing Exercise ...................................................................40

7. Editing In ARRIS ....................................................................43
   The Edit Menu .........................................................................43
   Move Everything In An Area ..................................................44
   Entity Filters ............................................................................46
   Search Methods .......................................................................47
   Edit Actions ............................................................................48

8. Basic Entity Parameters & Commands .....................................49
   Lines .......................................................................................49
   Circles / Arcs .........................................................................50
   Text ........................................................................................51
   Dimensions .............................................................................52
   Patterns ...................................................................................53
   Repeated Items ........................................................................54
   Raster Entity ............................................................................55
   Surfaces ..................................................................................56

9. Data Files ..............................................................................57
   Projects ..................................................................................57
   Databases ...............................................................................58
   Layers .....................................................................................59
   Drawings ................................................................................59
   Sheets .....................................................................................60
   Viewports ...............................................................................60

10. More Things To Know ..........................................................61
    The Object Snap Menu ............................................................61
    The Layer Menu .....................................................................62
    Copies ....................................................................................64
    Saving Your Work ..................................................................66
1. Introduction

Getting Started

The ARRIS New User Tutorial is designed to be a first introduction to using ARRIS. If you are using computer aided design for the first time, this document will introduce you to the basic concepts of drawing in ARRIS. If you are familiar with another computer aided design software, it will be very important to review this tutorial to understand the way ARRIS operates, which may be very different than the CAD software you are familiar with.

Chapter 1 - Introduction

Getting started, references to other ARRIS documentation, where to find help, the ARRIS Web Training Center, and how we present instructions.

Chapter 2 - The ARRIS User Interface

This chapter contains a basic outline of the menu system. It includes a description of the different menu areas and menu types in ARRIS and the functions that are found there.

Chapter 3 - The ARRIS User Interface - Hardware

This chapter contains a description how ARRIS interacts with the user through the keyboard and mouse. It documents important functions of the Function Keys, the Mouse, Special Keyboard Keys, and explores the ARRIS Mouse Motion feature.

Chapter 4 - Important Concepts

This chapter covers a few basic important concepts including the XYZ Cartesian Coordinate system, XY Forcing, and Points.

Chapter 5 - Parameters

In this chapter you will draw learn about ARRIS entity parameters, how they relate to an entity when it is placed, and how to set parameters and save the settings in catalogs.

Chapter 6 - Drawing In ARRIS

In this chapter you will draw lines as an exercise in working with ARRIS. Included are the concepts of input using the mouse, input using coordinates, new reference points, and double reference points.

Chapter 7 - Editing in ARRIS

This chapter outlines drawing basic ARRIS entity types. The process is similar to that for lines.

Chapter 8 - Basic Entity Parameters & Commands

This chapter shows the primary parameters and placement commands for the basic entities.

Chapter 9 - Data Files

This chapter explains how ARRIS data is stored on the disk, the various data file types, and goes step by step on how to create a project and a database.

Chapter 10 - More Things To Know

This chapter covers the additional topics of the Object Snap menu, the Layer menu, Copies, and Saving Your Work.
Introduction

Where To Find Help

Most of the topics found in this New User Tutorial are also covered in the ARRIS Learning Guide. Refer to the ARRIS Learning Guide for more information.

Information about ARRIS is covered in much greater depth in the ARRIS Encyclopedia. This document is an A to Z reference guide to the various topics in ARRIS. References to a particular topic in the ARRIS Encyclopedia are noted throughout this document.

Middle Button Menu Help

ARRIS has a built-in Menu Help feature which provides information about menu buttons and the functions they perform. To activate it, place the cursor over the menu button and select using the middle mouse button or the F2 function key on the keyboard.

When the Menu Help is activated, the Menu Help menu appears. This menu contains a Title for the menu button and the text or icon contained within the selected menu button.

Below the title are the Source Menu and Menu Library boxes. The Source Menu box displays the name of the ARRIS menu which contains the selected menu box. The Menu Library box displays the name of the menu library in which the source menu is archived.

The Command Description box displays a description of the command which is executed when the menu box is selected. Note that not all menu boxes will have a description.

The lower portion of the Menu Help menu shows both the left and right click ARRIS mnemonic command string which is executed when the menu box is selected. There are also buttons here to add the left or right click command to the User Toolbar, or to run the command. The User Defined Right Click Command Setup button clears the menu and brings up the Right Click Command Setup menu. The Mouse Right-Click Shortcut and User Toolbar features are described under their respective topics in the ARRIS Learning Guide.

For more information on the Menu Help feature, refer to the Help topic in the ARRIS Encyclopedia.
The ARRIS Web Training Center

There is a wealth of information available on the ARRIS web site at www.arriscad.com in the Learning section.

The ARRIS Web Training Center is a series of web pages on ARRIS topics that allow you to interactively learn about ARRIS at your own pace. The Web Training Center is easy and fun to use. This center is continuously being updated and expanded to bring you more ARRIS topics.

The Learning section of the ARRIS web site also contains a Library link to the ARRIS Bookshelf. This page contains all of the ARRIS documentation, including the ARRIS Learning Guide and ARRIS Encyclopedia, as well as instructions on installing, updating, and authorizing ARRIS. The Bookshelf documents are available in .pdf format and may be downloaded free of charge. They may also be viewed directly on the web.
Introduction

How We Present Instructions
Following are the conventions used throughout this New User Tutorial to describe the operation of ARRIS.

Typographical Conventions

Bold type
Prompt messages, File names, or specific keystrokes you must enter, as in enter 1'4".
Names of menus.

Underlined type
Menu buttons and headings.

Italic type
Highlights terms and concepts when introduced for the first time.

Keyboard Conventions

Enter, Return, <cr>
Indicates you should press the key labeled Enter or Return.

F1, F2, F3, etc.
Indicates you should press a function key. Alternatively you can use the mouse buttons if you have the buttons set up for the required function key. The default settings for the left, middle, and right buttons are F1, F11, and F3 respectively.

Mouse Conventions

Pick
Use the mouse to point to an entity or location on the graphics screen, and quickly press and release either the left or right mouse button, as instructed. “Use F1 to pick ...” Means pick with the left mouse button.

Select
Use the mouse to point to a menu item and press the left mouse button (F1) once.

Drag
Use the mouse to point to a location on the graphics screen, then hold it down as you move the mouse.

Instructional Terms

Option
A choice on a menu or prompt line.

Prompt
An on-screen statement that asks for a response.

Enter
Means to type letters or numbers on the keyboard, then press the Enter or Return <cr> key.
### 2. The **ARRIS** User Interface

#### The **ARRIS** Menu System

The **ARRIS** menu system is logically organized to quickly and easily find the various tools. It is consistent across all supported hardware platforms.

**ARRIS** menus are very information-rich. Many of the menu boxes before you contain not only icons which execute drawing or editing commands, but display current parameters or other information. The menus are hierarchical and context sensitive meaning that specific menus displayed depend on previous selections made.

The **ARRIS** menus are divided into 10 sections:

- ● Main Menu
- ● Application Menu
- ● Application Sub-Menu
- ● Status Menu
- ● Windows Menu Bar
- ● View Control Bar
- ● User Tool Bar
- ● Prompt & Message Line
- ● Point Coordinate Display
- ● Display Window

These sections are illustrated further on the pages that follow.
The **ARRIS** User Interface

### The **ARRIS** Main Menu / Windows Menu Bar

The major functions in **ARRIS** which are common to all applications are found on the Main menu, which is located across the top of the **ARRIS** display. The functions found here include all file creation, opening, manipulation, and saving functions as well as all **ARRIS** environmental and preference settings, undo/redo, edit and copy functions.

Windows Menu Bar: Most of the functions found on the **ARRIS** Main Menu are duplicated on the Windows Menu Bar, providing a more traditional Windows interface.

Project / File Display: This box indicates the currently open Project and Project Page, or Working Directory and Database / Drawing / Sheet, depending on the current file selection mode. Selection of this box will open menus to select and open

Save Pull-down Menu: This menu contains functions for saving **ARRIS** files including save, save as, copy, rename, briefcase, and

Environmental Mode Display: Indicates the current Model / Sheet / Viewport Space mode.

Layer Menu: Selection of this box brings up the Layer Menu. All Layer manipulation functions are located here.

Query: Opens the Query pull-down menu. From this menu you can query the properties of graphic entities and measure point locations, distances, angles, areas, and

Edit: Opens the Edit Pull-down menu. Moves, stretches and parameter edits are

Customization Menu: Contains tools for customizing the **ARRIS** environment including mouse buttons, mouse gestures, menu right-click, general environmental preferences, the user toolbar

Color: The Color Menu contains tools for modifying, saving, and loading **ARRIS** color maps.

Plot / Print Menu: Contains functions and settings for plotting and printing drawings

Viewport Menu: Contains functions and settings for creating, placing, and manipulating viewports. Functions available depend on the current Model/Sheet/Viewport

Current Work Layer: Displays the number and name of the current work layer. Selecting this box brings up the Layer menu on which the current work layer may

Copy: Opens the Copy pull-down menu. All copy functions are

Workplane: Contains tools to adjust the XYZ coordinate system to a given plane

File Pull-down Menu: Contains functions for file manipulation including creating, opening, deleting, import, and export of **ARRIS** files. There are also settings for the **ARRIS** environment and file

Scale: Indicates the current scale of the drawing. Scale is relevant only to plotting and sizing of certain entities relative to "real world" such as text. Selecting this box sets the current drawing scale.

Undo / Redo: Selection executes an Undo (left arrow) or Redo (right arrow) of the last drawing

Object Snap: Contains tools to specify particular locations on a given object such as the midpoint of a

Plug-ins: Displays the available and currently loaded plug-in applications to **ARRIS** and provides tools to load and unload them.
The ARRIS User Interface

The ARRIS Application Menu

ARRIS Application Menus are located along the right side of the screen toward the top and offer a choice of general topics. The Application Menu displayed is the Application menu for the current ARRIS Plug-in or Application.

When a topic is selected on the Application Menu, the Application Sub-menu and Status Menu for the selected topic are activated offering more choices and displaying parameters for that topic. For example, if the lines icon is selected on the ARRIS Draw Application Menu, the Lines Application sub-menu and Status menus are activated which allow the user to select, set parameters for, create, and draw lines.

The ARRIS Draw Application Menu is illustrated below:

Application Menu Title: Displays the name of the Application Menu currently loaded.

Lines: Selection of this box displays the Lines Application Sub-Menu and Status menu.

Circles: Selection of this box displays the Circles Application Sub-Menu and Status menu.

Solids: Selection of this box displays the Solids Application Sub-Menu and Status menu.

Text: Selection of this box displays the Text Application Sub-Menu and Status menu.

Dimensions: Selection of this box displays the Dimensions Application Sub-Menu and Status menu.

Zones: Selection of this box displays the Zones Application Sub-Menu and Status menu.

Notes: Selection of this box displays the Notes Application Sub-Menu and Status menu.

Patterns: Selection of this box displays the Patterns Application Sub-Menu and Status menu.

Walls: Selection of this box displays the Walls Application Sub-Menu and Status menu.

Repeated Items: Selection of this box displays the Repeated Items Application Sub-Menu and Status menu.

Slabs & Paths: Selection of this box displays the Slabs & Paths Application Sub-Menu and Status menu.

Labels: Selection of this box displays the Labels Pop-up Menu.

Reports: Selection of this box invokes the Reports Command.

Raster Entity: Selection of this box displays the Raster Application Sub-Menu and Status menu.

Raster Background: Selection of this box displays the Raster Background Pop-up Menu.
The **ARRIS** User Interface

The **ARRIS** Application Sub-Menu

The **ARRIS** Application Sub-Menu is context sensitive. When an entity type icon is selected on the Application menu, the Application Sub-Menu will change to display more detailed choices for selecting parameters, placing, and editing the entity type selected.

**Application Sub-Menus** are sub-divided by headings to group commands for **Select**, **Place**, **Create**, and **Utilities**. Depending on the particular entity involved, the number of buttons under each heading will vary, and not all **Application Sub-Menus** will contain all headings.

The **Lines** Application Sub-Menu is shown below as an example.

---

**Application Sub-Menu Title:** Displays the name of the Application Sub-Menu currently loaded.

**Select:**
Selection of this box displays the Select Menu for the entity type you are working with.

**Place:**
All buttons found under the Place heading are for the various methods of placing the

**Create:**
Buttons found under the Create heading are for functions which create or set parameters for the entity covered on this Application Sub-Menu. The functions for creating and manipulating Catalogs used with this entity type are also found under the Create heading.

**Drawing Tools:**
For certain entity types this button will bring up a Drawing Tools menu, which contains additional placement and editing tools appropriate for the

**Right Click Selection:** On some placement commands, a Right Click selection will bring up the Object Snap Flyout menu which allows you to select an object snap function to precisely locate the next point input. This feature is when drawing a line using the Single Line, Running Line, Box, Multiple Line, Drop, and Spline Line functions on the Lines

**Utilities:**
On some entity Application Sub-Menues there are additional functions appropriate to editing or manipulation of the entity type found under the Utilities

**Parameters:**
For most entity types this button will bring up the Select menu for the entity.
The ARRIS Status Menu

The ARRIS Status menu is also context sensitive. When an entity type icon is selected on the Application menu, the Application Sub-Menu will change to display more detailed choices for selecting parameters, placing, and editing the entity type selected. The Status Menu will also change to show the parameters and their current settings which apply to the entity type chosen.

The left end of the ARRIS Status menu remains constant. This portion contains the settings which are common to all entity types, such as pen and color.

**XY Forcing:**
Forces the input of points to the X or Y axis (which ever is closer to the point input by the cursor) relative to the current reference point - usually the last point entered. This is the orthogonal "snap" feature of

**Pen:**
The pen with which the entity is to be plotted. Pen settings may be 0-15. The actual pen weight for each pen setting is assigned in a penmap. Pen 0 is a special pen in ARRIS. Entities drawn in pen 0 will display on the screen but will not plot.

**Distance Relative:**
With this setting Off, coordinate input is referenced from absolute 0 in the XYZ coordinate system. With Distance Relative On, the coordinate input is referenced relative to the current reference point.

**Color:**
The color in which the entity is displayed on the screen. Color settings may be 1 to 255. The actual RGB color value for each color setting is assigned in a colormap. Color 0 in ARRIS is the screen background. Entities

The Lines Status menu is illustrated below as an example:

**Line Type:**
Displays a number which corresponds to the type of line - 0=Solid, 1=Dashed (1 Dash, 1

**Dash Lengths:**
For dashed line types, displays and sets the dash and space lengths in paper (plotted) fraction of an inch

**Word Parameters:**
For word line types, displays and sets the text, font and text

**Dash Mode:**
Sets how dashes are handled at the end of the line.

**Circle Parameters:**
Displays and sets parameters used for placement of Circles and Polygons including Center Point, Center Point symbol size, Number of Polygon Sides, and Arc

The User Interface

ARRIS New User Tutorial
The ARRIS User Interface

The View Control Bar

The ARRIS screen display commands are conveniently located together on the View Control Bar just below the main ARRIS display window. These commands include zooming, changing the view angle, and launching the current view to Sigma Design’s eZ product.

A diagram of the View Control Bar is shown below along with an explanation of each icon. The View Pop-up menu is also shown.
The User Toolbar

The ARRIS User Toolbar is conveniently located below the ARRIS display window, just above the Status menu. It contains 22 boxes which may be individually user defined to contain an ARRIS command. The User Toolbar is always available, regardless of which functions are otherwise active in ARRIS.

The ARRIS User Toolbar is easily customized using either one of two methods. The “Drag and Drop” method allows you to select an ARRIS command from any other menu and place it on the User Toolbar. The “Setup” method allows you to define the box manually using any ARRIS command or string of commands desired.

To drag and drop a command to the toolbar, select the ARRIS command desired from any other menu using the middle mouse button or F2 function key on the keyboard.

The Quick Help pop-up menu will appear. Select the Toolbar box on the Quick Help menu. The cursor will become a box which you may now drag over the User Toolbar location where the command is to be placed. Drop the command in place on the User Toolbar by left-clicking the desired box on the toolbar.

A User Toolbar box may also be customized by right-clicking the toolbar box. Drag the toolbar box cursor up to the display window and left click.

This opens the Toolbar Setup Menu which displays the icon or text displayed in the box, and the command(s) executed when the box is selected. Edit the display or command by selecting them on the Toolbar Setup menu. Select the OK button to save the changes.

A customized User Toolbar may be saved or opened by selecting the Tool Bar box at the left end of the User Toolbar and following the prompts. A custom toolbar is saved by name and there are User and System default toolbars which are always available. Refer to the Toolbar Menu topic in the ARRIS Encyclopedia for more information.
The ARRIS User Interface

The Prompt / Message Line

The **Prompt Line** and **Message Line** on the ARRIS menus is extremely important. This is where ARRIS communicates with you.

When ARRIS needs information or requests input, the **Prompt Line** is where this request will be shown. The **Prompt Line** is located on the left side, just below the main drawing display window. If no command is running, this line displays “Make Selection”.

The **Message Line** is the white line just below the prompt line. It is here that ARRIS displays additional information with prompts that will help you understand what ARRIS is prompting for or offer additional input information. For example often when a command which loops for multiple point input is prompting for a point, the **Message Line** will display “<cr>, F10 to Exit”. This indicates that if you use the F10 function key (or mouse button equivalent) to enter a point, or press the enter key, the loop will terminate and exit the command.

When commands or input is typed at the keyboard, the typed command or input is echoed on the **Message Line** as it is typed.

The **Message Line** is also where errors are shown. If an error such as an invalid input or command occurs, the box at the left end of the **Message Line** will highlight red and the error message will be shown on the **Message Line**.

Point Coordinate Display

To the right of the **Message Line** is the **Point Coordinate Display**. This box displays the X, Y, and Z coordinates of points which are input into ARRIS in one of three modes. Point coordinates are shown either continuously as the cursor moves, only when a point is entered in ARRIS, or not at all (off). The coordinates are shown depending on the current Distance Relative setting either relative to the database origin (off) or relative to the current reference point - usually the last point entered (on). The Point Coordinate setting may be set on the Screen Modes menu by selecting the **Point Coordinate Display**.
The **ARRIS** Display Window

The Display Window is the portion of the **ARRIS** menus where the drawing is actually displayed. The display of your drawing will depend on the current view.

The Select Entity feature is activated by selecting an existing entity in the Display Window. This feature is explained further below.

Pop-Up menus appear in the display window as needed to set parameters or otherwise obtain information for or display output from the current command. Pop-Up menus are discussed on the next page.

**Select Entity**

The Select Entity function in **ARRIS** allows you to select an existing entity in the drawing and then perform an action on it such as query, match parameters, match layer, or any one of several edits.

To use this feature, at the Make Selection prompt when no other command is active, select an entity on the drawing with a left-click. One of two Select Entity menus will pop up, depending on the layer of the entity selected.

If the entity is on the current work layer, the menu will show the entity type in the title bar and present a selection of edits as well as the option to set the current parameters to match those of the selected entity.

If the entity is not on the work layer, the title will reflect the entity's layer number and name and will offer the additional functions of setting the layer modes of the entity's layer or making it the work layer.

Multiple entities may be selected by pressing and holding the left mouse button, dragging the mouse to form a fence, and then releasing and left-clicking again to end. If the drag is left to right, all entities completely inside the fence will be included in the selection.

If the drag is right to left, all entities at least partially within the fence will be included. A menu will pop up from which you may select an action to be performed. Actions which are not available for the given group of entities in the fence are grayed out.

The Select Entity feature is one of the quickest and easiest ways to set parameters for drawing by simply selecting and matching the parameters of an existing entity. For more information see the Select Entity topic in the **ARRIS** Encyclopedia.
Pop-Up menus are used throughout ARRIS to set parameters or otherwise provide information needed to carry out a specific function. Pop-Up menus appear as needed within the drawing display window portion of the screen. The Line Create Pop-Up menu is shown here as an example with many of the features of pop-up menus noted.

**Title:**
A menu box displayed in dark blue is a title. Title boxes may or may not be selectable.

**Parameter or Data:**
A menu box displayed in medium blue is a parameter setting which may be changed by selecting the

**Selectable:**
A menu box displayed in gray is a parameter, choice or command which may be activated by selecting the

**Highlight:**
A menu box displayed in light blue is a parameter, choice or command which is the current selection.

Note: Colors noted are menu colors when using the system standard colormap.

**Menu Title:**
Displays the name of the Pop-Up menu. A Pop-Up menu may be dismissed by clicking on the “X” in the top right corner or anywhere on the title

**Sample:**
Menus dealing with entities may have a sample box showing how the entity will appear when it is drawn using the currently set

**Information:**
A menu box displayed in dark gray displays information only. The box is not selectable.

ARRIS Select menus are Pop-Up menus which allow easy selection of an entity to place - usually from a Catalog. The various Entity Select menus are similar in design, varying only slightly to accommodate the particular entity. The Line Select menu is shown here.

**Catalog:**
The current Catalog name is shown here.

**View:**
The items on the list may be viewed visually with samples or by text name & description

**Name & Description:**
The name and description of the selected entity style are shown here.

**Slide Bar:**
Allows you to page through multiple pages if the list of items is longer than the available menu space to show them. The solid bar within the menu box field shows the relative amount and location of the items on the list currently shown in the menu. Selection on the slide bar itself pages the menu display to the relative

**Create:**
Brings up the Create menu for the entity where styles may be

**Toolbar:**
Places the selected Entity Style on the User Toolbar.

**Preview:**
Previews a larger sample of the Entity Style.

**Place:**
Places the selected Entity. Specific placement commands may also be selected on the Application Sub-Menu.

**Cancel:**
Cancels the entity placement and clears the menu from the
3. The ARRIS User Interface - Hardware

The ARRIS User Interface consists of the computer keyboard and mouse, and audio speakers if your computer has a sound card installed.

ARRIS uses the keyboard for many specialized functions. The Function Keys are used for point input to designate what type of point is to be entered. There are many Special Keys and Control key functions that perform special tasks when drawing. These functions are outlined in this chapter.

ARRIS uses the mouse on your computer as a cursor pointing tool. This allows you to point to and select User Interface buttons and graphic entities on the screen by moving the mouse and clicking on them. In ARRIS the mouse is used in three ways. The first use is for selection of buttons on the Graphic User Interface. The second use of the mouse is for selection of entities or points in the Display Window. The third use of the mouse is the Mouse Gestures feature. These three functions are explained further in this chapter.

While you can draw using a 2 button mouse, having 3 buttons is more convenient. A pointing device or mouse having more than 3 buttons is very useful in ARRIS, provided that the Windows driver for the pointing device can be set so that the functions on the extra buttons are set by ARRIS. A mouse with a scroll wheel as the middle button may be used, however the scroll wheel itself is not currently supported and has no use in ARRIS.

ARRIS has support implemented internally for audio capability in the program, however there are no current applications that use sound. The sound capability may be switched On and Off in ARRIS in the Preferences menu.
Function Keys

The Function Keys (F keys) found on the keyboard are pre-programmed to perform specific actions in ARRIS. Depending on the location of the cursor, the function keys will do different things. The buttons on the mouse are also programmed to duplicate some of the keyboard function keys.

If the cursor is over the Display Window, and a command is not active, the F1 and F2 function keys (or corresponding mouse buttons) are used to select an object for further action such as editing, query or matching the parameters of the entity. Refer to the Select Entity discussion earlier in this tutorial and the Select Entity topic in the ARRIS Encyclopedia.

If the cursor is over a Menu button and a function key F1, F2, or F3 (or corresponding mouse button) is pressed, a different menu function is invoked depending on the function key used to make the selection.

Menu

F1
Makes a menu selection.

F2
Invokes the On-Line Help pop-up menu.

F3
Makes a shortcut menu selection. Note that not all menu buttons have a shortcut defined.

If the cursor is over the Display Window, the action performed is dependant on the active command status and the function key used to make the selection.

If no command is active and the selection is made with the F1 or F2 key, the selection invokes the Select Entity feature. This feature is used to match parameters, query, or edit the entity.

Display Window No Command Active

F1
Edit, match, or query any object.

F2
Query any object.
If the cursor is over the **Display Window**, and a command is active, generally a function key is used to select a point. The specifics of the selection are determined by which function key (or mouse button) is used. A list of the most common Display Window Active Command Function Key functions is shown to the right.

### Display Window Active Command Function Key

<table>
<thead>
<tr>
<th>Key</th>
<th>Label</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>F1</strong></td>
<td>Draw Commands</td>
<td>Places a new point with respect to XY Forcing. Edit Commands: Selects the nearest entity or point.</td>
</tr>
<tr>
<td><strong>F2</strong></td>
<td>Places a new point, ignoring XY Forcing.</td>
<td></td>
</tr>
<tr>
<td><strong>F3</strong></td>
<td>Snaps to an existing data point.</td>
<td></td>
</tr>
<tr>
<td><strong>F5</strong></td>
<td>Snaps to the nearest existing line or wall.</td>
<td></td>
</tr>
<tr>
<td><strong>F7</strong></td>
<td>Snaps to the intersection of 2 lines or Reset the current reference point to the nearest existing data point.</td>
<td></td>
</tr>
<tr>
<td><strong>F9</strong></td>
<td>Draw Commands: Stops the function. Edit Commands: Provides additional fencing options. Looping Commands: Special functions. In most cases an <code>&lt;Enter&gt;</code> or <code>&lt;Return&gt;</code> will function the same as an F10.</td>
<td></td>
</tr>
<tr>
<td><strong>F10</strong></td>
<td>Snaps to display list points or to arc endpoints.</td>
<td></td>
</tr>
<tr>
<td><strong>F11</strong></td>
<td>Snaps to the nearest Repeated Item Node point.</td>
<td></td>
</tr>
<tr>
<td><strong>F3</strong></td>
<td>Snaps to the existing data point inside a Repeated Item nearest the crosshair.</td>
<td></td>
</tr>
<tr>
<td><strong>F4</strong></td>
<td>Finds the nearest displayed entity.</td>
<td></td>
</tr>
<tr>
<td><strong>F5</strong></td>
<td>Snaps to the nearest line within a Repeated Item. The point identified on the line is determined by the XY Forcing mode.</td>
<td></td>
</tr>
<tr>
<td><strong>F6</strong></td>
<td>Snaps to the insertion point for the line of text within a Repeated Item nearest the crosshair.</td>
<td></td>
</tr>
<tr>
<td><strong>F7</strong></td>
<td>Snaps to the intersection of 2 lines within a Repeated Item nearest the crosshair.</td>
<td></td>
</tr>
<tr>
<td><strong>F8</strong></td>
<td>Snaps to the nested Repeated Item insertion point nearest the crosshair within a Repeated Item.</td>
<td></td>
</tr>
<tr>
<td><strong>F9</strong></td>
<td>Resets the current reference point to the nearest data point to the crosshairs within a Repeated Item.</td>
<td></td>
</tr>
</tbody>
</table>

The less-used function key operations primarily dealing with Repeated Items may be reached by pressing and holding the Shift key and then pressing the function key.

For more information and a complete listing of all function key actions, refer to the **Function Keys** topic in the ARRIS Encyclopedia.
The ARRIS User Interface - Hardware

Graphic Interface (Menu) Mouse Button Selection

When the cursor is over the Graphic User Interface (menus), a mouse button selection will select the button under the cursor. The selection function depends on the mouse button used. The menu selection functions are shown in the diagram to the right.

Display Window Mouse Button Selection

When the cursor is over the Graphic Display Window, a mouse button selection will select or place a point, or select an entity. The selection or placement functions are described in the diagram below.

The left mouse button is used extensively for display window selection and is context sensitive. When drawing, a left mouse click will place a new point in the database at the location of the cursor with respect to the XY Forcing setting. Refer to the XY Forcing discussion in the Important Concepts chapter. When ARRIS is prompting to select an entity, the entity may be selected with a left click anywhere on the graphic display of the entity. With no command running, a left click selection may be used to select and highlight an entity to match parameters or copy or edit using the Select Entity feature. Refer to the discussion on Select Entity in the Graphic User Interface chapter of this tutorial.

Menu Selection Mouse Button Functions

Left Button
Makes a menu

Middle Button
Brings up the Middle Button Menu Help Pop-Up for the menu button selected...

Right Button
Makes a Shortcut menu selection. Note that not all menu buttons have a shortcut command defined. In this case the selection is the same as with the left button.

Display Window Selection Mouse Button Functions

Left Button
Places a new database point. A Left Click may also be used to select a

Middle Button
Finds and snaps to an existing Display List point.

Right Button
Finds and snaps to an existing database point.

When the cursor is over the graphic display window, the mouse button functions by default duplicate the F1, F11, and F3 Function Key functions for the left, middle, and right mouse buttons respectively. The mouse buttons may be customized to duplicate any function key. Refer to the discussion of Function Keys earlier in this chapter, and the Mouse and Function Keys topics of the ARRIS Encyclopedia.
Special Keys

**Special Keys** are keys found on the keyboard which are pre-programmed to perform specific actions in ARRIS. These are generally used in conjunction with other commands, or are keyboard shortcuts to some of the drawing status commands in ARRIS. The location of the various Special Keys on the keyboard will vary somewhat, depending on your specific keyboard.

**Special Keys** and their functions in ARRIS are listed below. Note that Control Key (Ctrl) functions are performed by pressing and holding the Control Key down and then pressing the other key shown. ARRIS has 2 sets of Control Key functions available - the standard set and an MS Windows emulation set. The desired Control Key set may be set on the Preferences menu. For a complete listing of Special Keys and their functions, refer to the Special Keys topic in the ARRIS Encyclopedia.

**Esc**  **Cancel The Active Command**

The *Escape* key is used to cancel any active command. Be cautious as some ARRIS commands change parameter settings in the course of executing the command function. Using the *Escape* key will cause the command to terminate immediately, without resetting the parameters back to their original setting. Note that the F10 function key is used by many repeating commands with point input to end the command. If ARRIS prompts with a message to F10 or <cr> to exit, the F10 (or Enter) key should be used instead of the *Escape* key, allowing ARRIS to perform clean up functions before exiting the command. See also the discussion of the F10 key under Function Keys earlier in this chapter.

**Tab** or **\**  **Toggle the Cursor Lock On/Off.**

The cursor lock is used in conjunction with XY Forcing to lock the cursor for the next point input to the X or Y axis, relative to the current reference point. When the cursor is locked to an axis and an existing point off the axis is selected, the point input is precisely aligned with both the current reference and the point input along the axis locked.

**Ctrl** + **K**  **Re-Display The Menus.**

Refreshes the menu display should it become obscured.

**Ctrl** + **U**  **Clear The Prompt Line.**

**Ctrl** + **O**  **Toggle the XY Forcing On / Off.**

This key functions the same as if the XYF menu button had been pressed.

**Ctrl** + **Y**  **Toggle the Graphic Cursor On / Off.**

If the cursor is left off by the abnormal exit of a command, it is easily restored with this key.

**Ctrl** + **R**  **Display The Last Command String Entered.**

Displays the last mnemonic command string on the message line. This is an easy way to tell what the mnemonic string is for any ARRIS command. Simply select the menu button for the desired command and then type <Ctrl> R and Enter.

**(!)**  **Display the value of a variable or calculation to the message line.**

To perform a mathematic calculation type ! and then the calculation followed by the Enter key. The calculation will be performed and the answer displayed on the message line. For example !2+3 will display the answer, 5.
Mouse Gestures

The Mouse Motion Command Interpreter (MCI) is easy to master and is one of the most powerful features of ARRIS. It allows you to execute a command by simply pressing the right button of your mouse and dragging the cursor.

To illustrate this feature, we will discuss how to execute the Zoom Window command using MCI. To begin, move the crosshair on the screen to the lower left corner of an area you wish to enlarge. Press the right button of the mouse and while holding it down drag the cursor up and to the right (Figure 1). When you get to the upper right corner of the area you want to enlarge, release the right button of the mouse. The view will change, zooming in to the area where you moved the mouse. Notice that while you moved the mouse across the screen, the cursor left a trail of white dots (Figure 2). This is a visual reference that helps you follow the mouse movement without looking away from the screen.

Now try the opposite motion. Press and hold the right mouse button down and drag the mouse down and to the left. Release the right mouse button. This executes the Last Window command, which will restore the view on the screen to the previous view. You have now mastered the concept of mouse motion.

There are 16 different mouse motions which execute 16 different ARRIS commands. These motions and the corresponding current command set are shown in the Mouse MCI menu. This menu is found by selecting the Customize icon in the upper right corner of the Main Menu, then selecting the MCI icon. The Mouse MCI menu with the 2D Standard default command set is shown on the next page.

For the most basic commands that are executed hundreds of times a day, Mouse MCI is an essential tool. The more you use it, the faster it will become, and the more intuitive it will be. It is one of the features of ARRIS that Power Users say they can’t live without!
The 16 mouse motions available in the MCI feature are easiest to remember when thought of as 2 groups of 8 motions. The first group of 8 consist of the 4 basic motions of up \( \uparrow \), down \( \downarrow \), left \( \leftarrow \), and right \( \rightarrow \) plus the 4 diagonal motions up & left \( \uparrow \leftarrow \), up & right \( \uparrow \rightarrow \), down & left \( \downarrow \leftarrow \), and down & right \( \downarrow \rightarrow \). The second group of 8 is a repeat of the first with the addition of the opposite motion while continuing to hold the right mouse button down. For example click and hold the right mouse button and drag the mouse down and then back up \( \uparrow \), then release the mouse button. This executes the Redraw command which refreshes the current screen.

The Mouse MCI feature is also customizable. The 16 commands mapped to the Mouse MCI may be changed to any ARRIS command, or combination of commands you desire. This is easily done on the Mouse MCI menu.

To edit the command which is executed when a mouse gesture is performed, select the box displaying the gesture on the Mouse MCI Menu. The current mnemonic command for the mouse gesture selected will be displayed on the Message Line and ARRIS will prompt for a new command for the mouse gesture. Type the new mnemonic command desired at the keyboard and enter. Refer to the Mnemonics topic later in this chapter for more information on mnemonic commands.

The command description text string which appears below each mouse gesture may also be edited by selecting the box on the menu where it appears. The current command description will appear on the Message Line and ARRIS will prompt for the new command description text. Type the new description and enter. This command description is also displayed on the Message Line when the mouse gesture is executed.

A custom mouse gesture set may be saved and loaded by name as a style using the buttons found at the bottom of the Mouse MCI Menu. Buttons which load a default mouse gesture set for 2D drawing and for 3D modeling may also be found at the bottom of the Mouse MCI menu.

For more on how to use and customize the MCI feature, refer to the Motion Command Interpreter topic in the ARRIS Encyclopedia.
Mnemonics

At its core, ARRIS is a mnemonic, or command driven software. Mnemonics are text string commands which are entered in the command buffer or at the program command line. When a menu button is selected, the corresponding command text is passed to the command buffer.

Any ARRIS command may be entered by typing it at the keyboard. To see the corresponding mnemonic command for any menu button, select the menu button with the mouse, and then type <Ctrl> R (hold down the <Control> key and press the “R” key) at the keyboard. The previous command from the buffer is shown in the command line. While most ARRIS menu commands are long, cryptic, or otherwise difficult to type, some are not. For a few ARRIS users, particularly those who touch type, entering certain commands at the keyboard may be faster or otherwise preferable. Mnemonic commands are also handy when setting custom commands on the User Toolbar or when customizing a Mouse Motion set.

Commands may be strung together on the command line by separating each command with a semi-colon which is interpreted by the command buffer as an Enter or Return. If a command has prompts which are known, the answers to these may be “pre-entered” by separating the command and any prompt answer with the semi-colon. For example the pen command has 1 prompt - for the new current pen number. If you know the new pen number is to be 2, you can “pre-answer” in the mnemonic command string .

Many of the short 2-4 character mnemonic commands are older, simpler versions of their menu counterparts. While the basic outcome of the command is the same, short mnemonics generally have less “frills”. For example the “mva” command to move entities in an area does not highlight the entities to be moved after the area is defined like the Area Move on the Edit pull down menu does. In some cases the short mnemonics are actually called as sub-programs from a larger, more feature rich menu command.

A sample list of a few mnemonic commands is shown below. For more information on mnemonic commands and their use, see the ARRIS Mnemonic Command List, and the Menu and Sigmac topics of the ARRIS Encyclopedia.

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Displays and Zooms</strong></td>
<td></td>
</tr>
<tr>
<td>da</td>
<td>Display All (Zoom All)</td>
</tr>
<tr>
<td>dpe</td>
<td>Re-display</td>
</tr>
<tr>
<td>zmi</td>
<td>Zoom In</td>
</tr>
<tr>
<td>zmo</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>dly</td>
<td>Display Layer</td>
</tr>
<tr>
<td>clr</td>
<td>Clear Screen</td>
</tr>
<tr>
<td><strong>Set Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>pen</td>
<td>Set Current Pen</td>
</tr>
<tr>
<td>col</td>
<td>Set Current Color</td>
</tr>
<tr>
<td>xyf</td>
<td>Toggle XY Forcing On</td>
</tr>
<tr>
<td>nxy</td>
<td>Toggle XY Forcing Off</td>
</tr>
<tr>
<td>dsr</td>
<td>Distance Relative On</td>
</tr>
<tr>
<td>dsa</td>
<td>Distance Relative Off</td>
</tr>
<tr>
<td>rin</td>
<td>Repeated Item Name (Set)</td>
</tr>
<tr>
<td>rip</td>
<td>Repeated Item Parameters</td>
</tr>
<tr>
<td>blp</td>
<td>Broken Line Parameters</td>
</tr>
<tr>
<td>stp</td>
<td>Set Text Parameters</td>
</tr>
<tr>
<td><strong>Draw</strong></td>
<td></td>
</tr>
<tr>
<td>sln</td>
<td>Single Line (Running Line)</td>
</tr>
<tr>
<td>sal</td>
<td>Single Alternating Line</td>
</tr>
<tr>
<td>box</td>
<td>Rectangle of Lines</td>
</tr>
<tr>
<td>rio</td>
<td>Place the current Repeated Item</td>
</tr>
<tr>
<td>stx</td>
<td>Single Text</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
</tr>
<tr>
<td>ctx</td>
<td>Change Text</td>
</tr>
<tr>
<td>dla</td>
<td>Delete Area (All in fence)</td>
</tr>
<tr>
<td>mva</td>
<td>Move Area (All in fence)</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td></td>
</tr>
<tr>
<td>save</td>
<td>Save Database/Drawing/Sheet</td>
</tr>
<tr>
<td>bye</td>
<td>Exit ARRIS</td>
</tr>
<tr>
<td>nrf</td>
<td>New Reference Point</td>
</tr>
<tr>
<td>drp</td>
<td>Double Reference Point</td>
</tr>
<tr>
<td>load</td>
<td>Load Database/Drawing</td>
</tr>
</tbody>
</table>
4. Important Concepts

The XYZ Coordinate System

ARRIS uses a 3 dimensional Cartesian Coordinate System to locate all points in space. This system is defined by 3 mutually perpendicular lines or Axes which intersect at the drawing origin.

When seen in a normal plan view, the positive X axis extends to the right, the positive Y axis extends up toward the top of the screen, and the positive Z axis extends out from the screen toward the viewer.

ARRIS is inherently 3 dimensional. If working on a 2 dimensional drawing, objects are drawn with a default Z value of 0, placing them on the XY plane.

The normal ARRIS cursor in plan shows the X and Y axis. The longer leg of the crosshair indicates the positive direction of the axis. The small box on the end of the horizontal leg indicates the X axis.

The Relative and Absolute modes determine the point from which the next coordinate will be measured. The Relative mode is the most convenient because it allows coordinates to be specified relative to the current reference point, usually the last point entered. By contrast, the Absolute mode uses the database origin as a fixed reference point for all coordinate input. The box labeled Rel in the lower left corner of the Status menu controls which mode is active. When Rel is on, you are in relative mode. Toggle it to off for Absolute mode.

The X, Y, and Z coordinates of a point are displayed in the Point Coordinate Display box, located below the View Control Bar. Depending on the Point Coordinate Display mode setting, this display will show the X, Y, and Z coordinates of the cursor as it is moved, the coordinates of a point as it is entered, or no display at all. The X, Y, and Z coordinates of points are shown either relative to the Database Origin if ARRIS is in Absolute mode (Distance Relative OFF), or relative to the current reference point (usually the last point entered) if ARRIS is in Relative mode (Distance Relative ON).

For more information, refer to the Coordinate System and Origin topics in the ARRIS Encyclopedia.

XY Forcing

The XY Forcing mode setting is found on the Status menu in the lower left corner of the screen. When XY Forcing is ON, and a command requiring point entry is prompting for the point, when the point is actually input, it will be forced to align with the current reference point in either the X or Y axis direction, which ever is closer. Before the point is input, the cursor will show a drag line from the current reference point along the closer axis to the location where the new point would be placed.

This is the orthogonal “Snap” feature of ARRIS. This function is particularly useful for laying out lines (or walls) which are at 90 degree angles to one another.

For more information, refer to the XY Forcing topic in the ARRIS Encyclopedia.
Important Concepts

Points

A point is defined by 3 real numbers, the coordinates along the (X,Y,Z) axes of the coordinate system. For example the point (6.25,-80.3,12) would be 6.25 units to the right of the origin on the X axis, 80.3 units down (negative direction) from the origin on the Y axis, and 12 units out from the origin (towards the viewer) on the Z axis.

Each entity placed must have one or more points specified in order to define it's location in a drawing. These coordinates may be entered numerically from the keyboard or graphically using the mouse. The method chosen will depend upon the drawing task and the level of accuracy desired.

An example of several basic entity types and the data point location on the entity used to place or find them is shown below.

The ARRIS Display List contains the entity information in ARRIS broken down into their simplest elements. This is used to speed up the redisplay in ARRIS. Display List Points are points on the simplified entities in the Display List. The Display List information is stored in a file which is parallel to the layer file inside the ARRIS database.

Display List Points are not the same as Data Points. The easiest way to think of a Display List Point is that it is any visual point that you can see in an entity on the screen. We will use a Repeated Item - (A "Complex" entity) to illustrate the difference.

In the Repeated Item shown to the right, the red point indicates the Repeated Item origin. This is a Data Point. By definition a Repeated Item is a collection of one or more ARRIS entities which are grouped together and stored in a library by name. The green points indicate Display List Points. These are points on the object that would be data points if the object were broken down into it's simplest geometric form - such as lines and circles. Note that a Data Point is also a Display List Point.

Display List Points are addressable when ARRIS is prompting for a location. Normally when ARRIS prompts for an existing point, you would select it using the F3 key. The F3 finds existing Data Points in the database. To select a Display List Point, you would select it using the F11 key. Refer to the discussion on Function Keys in the ARRIS User Interface - Hardware chapter.
5. Parameters

Basic Methodology

When drawing in ARRIS the basic methodology is to set-up and draw. By this we mean set all of the parameters for the desired entity and then draw or place the entity. When an entity is placed in ARRIS, the current values of parameters which apply to that entity are what is used to define the entity for that particular placement. The same methodology holds true for editing - set-up and edit. Set all of the parameters to the values that you want the entity to have, and then change the entity. Note that once the entity is placed, the current parameter settings become properties of the entity itself.

There are several features in ARRIS that make the setup of parameters quick and easy. Once set, the parameters may be saved to a style and selected by the style name. For example, a dashed line used in a drawing to indicate things that are overhead will have the same look to it every time it is used. The line type, and dash parameters may be saved to a style called “Dashed”. Once saved, the “Dashed” style may be selected from a menu by name and thumbnail and all of the saved parameters are set as current, ready to place the dashed line.

Create An Entity Styles Catalog

To illustrate this we will work with the Line entity. We will first create an Entity Styles catalog and then create some lines to store in it.

Select: The Lines icon on the Application menu to bring up the Lines application sub-menu.

Select: Catalog under the Create heading on the Lines Application Sub-menu. This will bring up the Styles Catalogs menu.

Select: The New button.

Prompt: New catalog name

Enter: tutorial <cr>

Select: The Exit button.

You have just created an Entity Styles Catalog. The next step will be to create and save Line Parameter Styles into it.

Create Line Parameter Styles

Now that we have a catalog, we will create some line parameter styles and save them into it.

Select: Line under the Create heading on the Lines Application Sub-menu. This will bring up the Line / Curve Create menu.

We will start by creating a solid line.

Select: The Solid Line icon in the top left corner under the Line Parameters heading on the Line / Curve Create Pop-up menu. The line parameters below will change to activate only the parameters used by the line type you have chosen. The Line box will show a 0 for the line type (solid line). The Width parameter will be OFF. All other parameters dealing with dashes, etc. will be grayed out since they don’t apply to a solid line.
Parameters

Select: New under the Catalog heading on the left side of the Line / Curve Create menu.

Prompt: Style name
Enter: solid <cr>

Prompt: Style description
Enter: Solid Line <cr>

Prompt: Save pen and color?
Select: no. This means that when a line is placed using this style, it will be placed in the pen and color that is current at the time it is placed.

The solid line style is now saved and will appear on the list under the Catalog heading.

We will now repeat the process to create a dashed line which has a single length dash and a single length space alternating.

Select: The Dash Line icon in the top row, second from the left under the Line Parameters heading on the Line / Curve Create Pop-up menu. The line parameters below will change to activate the Width, Mode, Dash1, and Space1 parameters. The Line box will show a 1 for the line type (dashed line).

Each of the active parameter values may be set by selecting the box containing the current value. The values for our dashed line should be as follows:

- Width should be set to off.
- Mode should be set to normal.
- Dash1 should be set to .125.
- Space1 should be set to .125.

With these parameters our dashed line when drawn will have dashes that are 1/8" long, separated by a 1/8" space when plotted on paper (dash1=.125, space1=.125). The dash pattern will be centered along the length of the line, with shortened dashes appearing at the ends of the line depending on the length (Mode=normal). When plotted, the line thickness will be determined by the pen weight (Width=off).

We can now save the style similar to the way the solid line was saved.

Select: New under the Catalog heading on the left side of the Line / Curve Create menu.

Prompt: Style name
Enter: dash1 <cr>

Prompt: Style description
Enter: Dash Line 1 <cr>

Prompt: Save pen and color?
Select: no. This means that when a line is placed using this style, it will be placed in the pen and color that is current at the time it is placed.

The dash1 line style is now saved and will appear on the list under the Catalog heading.
Parameters

To fill out our tutorial catalog we will add one more line style, this time for a property line which has a long and a short dash length with the short dash repeating twice in a Long-Short-Short pattern.

Select: The Dash Line icon in the top row, right end under the Line Parameters heading on the Line / Curve Create Pop-up menu. The line parameters below will change to activate the Width, Mode, Dash1, Space1, Dash2, and Space2 parameters. The Line box will show an 8 for the line type (dashed line).

Each of the active parameter values may be set by selecting the box containing the current value. The values for our dashed line should be as follows:

- **Width** should be set to off.
- **Mode** should be set to normal.
- **Dash1** should be set to 1.
- **Space1** should be set to .125.
- **Dash2** should be set to .125.
- **Space2** should be set to .125.

With these parameters our property line when drawn will have a long dash that is 1” long, followed by 2 short dashes that are 1/8” long, each separated by a 1/8” space when plotted on paper (dash1=1, space1=.125, dash2=.125, space2=.125). The dash pattern will be centered along the length of the line, with shortened dashes appearing at the ends of the line depending on the length (Mode=normal). When plotted, the line thickness will be determined by the pen weight (Width=off).

Since the property line style is very specific, and a property line is likely to always be drawn in the same pen and color, we will set and save these parameters with the line.

Select: Pen on the left end of the Status Menu.

Prompt: Pen number (0-15) or none?

Select: 3. The pen box will change to indicate the pen number selected.

Select: Col on the left end of the Status Menu. This will bring up the Color Select Pop-up menu.

Prompt: Color number (0-255) or none?

Select: The bright green toward the left end of the bottom row of colors on the Color Select Pop-up menu. The color box will change to the color selected.

We can now save the property line style similar to the previous two.

Select: New under the Catalog heading on the left side of the Line / Curve Create menu.

Prompt: Style name

Enter: property <cr>

Prompt: Style description

Enter: Property Line <cr>

Prompt: Save pen and color?

Select: yes. This means that when a line is placed using this style, it will be always be placed in the pen (3) and color (green) that is current at the time the style is created.

The property line style is now saved and will appear on the list under the Catalog heading.
Parameters

There are now 3 line styles saved in the tutorial catalog. These will be used in the next chapter to illustrate placing lines.

The Create menu for other basic entity types including Circles, Text, Patterns, and Dimensions is very similar to the one for Lines. In each, the parameters which apply to the specific entity type are shown on the Create menu for the entity and may be set. The parameters for each of these basic entity types may be saved as a style in a catalog, similar to the example just shown for Lines. The same catalog is used for all of the basic entity types. Remember that an entity style selected from a catalog only recalls and sets the current parameters. Once an entity is placed, the parameters that were current at the time it was placed become properties of the entity and do not refer back to the catalog in any way. Changing parameters in a catalog does not affect any placed entities. The properties of the individual entity also do not relate to the layer, or to any other entity.

Refer to the Catalog topic in the ARRIS Encyclopedia for more information on catalogs. Refer to the individual entity topics in the ARRIS Encyclopedia such as Lines, Circles, Text, Dimensions, or Repeated Items for more information about parameters associated with the entity.
6. Drawing In ARRIS

In this chapter we will again use simple lines to illustrate drawing in ARRIS. ARRIS input is all about locating and placing points. Other entity types all work in much the same manner so once you master drawing lines, drawing other things will be easy.

As you go through the examples and drawing exercises, be sure you are familiar with the menus, function keys, and mouse buttons as described in the ARRIS Menu System and ARRIS Hardware User Interface chapters of this manual.

The Line Select Menu

In this exercise we will draw lines in the database using the line parameter styles created in the previous chapter.

Select: The Lines icon on the Application menu to bring up the Lines application sub-menu.

Select: The Select button at the top of the Lines Application Sub-menu. This will bring up the Line Select menu.

Select: tutorial on the list of available catalogs on the left side of the Line Select menu. This will display the 3 line styles created in the last chapter.

Select: The solid line style on the right side of the Line Select menu. The solid line style will highlight. Note that the parameter settings found on the Status menu at the bottom of the screen will change to reflect the parameters of the solid line style.

Select: The highlighted solid line style button again.

The selection of the highlighted line style will clear the Line Select menu from the screen and start the Running Line command.

Instead of selecting the solid line style again, you could also select the Place button at the bottom of the Line Select menu. This has the same effect, clearing the Line Select menu from the screen and starting the Running Line command.

Line Placement - Mouse Input

Continuing from the Line Select menu above, we will place the line we have just selected. When selecting either the highlighted solid line style again or the Place button on the Line Select menu, the Running Line command is started.

Prompt: First point of line

Move the cursor to a blank area on the screen.

Pick: A new point by clicking the left mouse button (F1). The cursor will change to a rubber band line with one end locked on the point you just placed, and the other on the crosshair.
Prompt: **Next point of line (F10 to restart)**

Move the cursor across the screen, stretching the rubber-band cursor line. If the **XY Forcing** setting is set to **On** on the left end of the **Status** menu at the bottom of the screen, the rubber band cursor line will be locked to either the X or Y axis (horizontal or vertical), which ever is closer to the relative position of the crosshair and the first point entered.

Pick: A second point by clicking the left mouse button (F1).

The solid line will be drawn across the screen from the first point to the second point entered. The line will be solid, reflecting the current line parameters as shown on the **Status** menu. It will be drawn in the pen and color that are currently set, also shown on the **Status** menu.

Prompt: **Next point of line (F10 to restart)**

The cursor will be the rubber band line, now anchored on the second point you entered. **ARRIS** is prompting for the next point, to draw the next segment in the continuous running line. Move the cursor up on the screen.
Pick: A point by clicking the left mouse button (F1).

Another solid line will be drawn across the screen from the second point to the third point entered. The line will be solid, reflecting the current line parameters as shown on the Status menu. It will be drawn in the pen and color that are currently set, also shown on the Status menu.

ARRIS will continue to prompt for points until the command is ended. If the F10 key is pressed while this command is prompting for the Next Point, the command will restart, and prompt for the First Point, allowing you to start a new series of running line segments. Pressing the F10 key at the First Point prompt will exit the command.

Try placing more lines. This time we will place the dashed line type that we created in the last chapter.

Select: The Select button at the top of the Lines Application Sub-menu. This will bring up the Line Select menu.

Select: The dash1 line style on the right side of the Line Select menu. The dash1 line style will highlight. Note that the parameter settings found on the Status menu at the bottom of the screen will change to reflect the parameters of the dash1 line style.

Select: The highlighted dash1 line style button again. This will start the Running Line command.

Prompt: First point of line

Move the cursor so that the crosshair is near one of the existing line endpoints that you have just entered.

Pick: The point using the right mouse button (F3).

ARRIS will snap to the existing line endpoint. The F3 key input finds an existing point in the database (see the discussion of Function Keys earlier in this manual). The cursor will become a rubber band line with one end anchored on the point you just selected and the other end on the crosshair.

Prompt: Next point of line (F10 to restart)

Move the cursor across the screen, stretching the rubber-band cursor line. If the XY Forcing setting is set to On on the left end of the Status menu at the bottom of the screen, the rubber band cursor line will be locked to either the X or Y axis (horizontal or vertical), which ever is closer to the relative position of the crosshair and the first point entered.
Pick: A second point by clicking the left mouse button (F1).

The dashed line will be drawn across the screen from the first point to the second point entered. The line will be dashed, reflecting the current line parameters as shown on the Status menu. It will be drawn in the pen and color that are currently set, also shown on the Status menu.

Prompt: Next point of line (F10 to restart)

Press: The F10 key twice to exit the command.

You have now drawn lines with point entry using the cursor and mouse, using the two most common function keys to create and select points in the database - the F1 and F3 keys. Next we will input points using coordinate entry at the keyboard.

**Line Placement - Coordinate Entry**

Most of the time when drawing, it is necessary to draw a line that is an exact known length, rather than arbitrarily picking points on the screen. This is easily done in ARRIS by using Coordinates to input the line. You may want to refer back to the XYZ Coordinate system discussion in the Important Concepts chapter if you are not familiar with the XYZ Cartesian Coordinate System.

Any time ARRIS is prompting for a point input, you may enter coordinates at the keyboard. X, Y, and Z Coordinates are entered in order - X, then Y, then Z. Each coordinate is separated by a comma. If there is no X, Y, or Z component, that component in the coordinate entry is not required to be entered, however the comma place holder is required if there are components after the one not included.

For example, a line which is 20 feet in the positive X direction (to the right) may be entered as just 20, since there are no Y or Z components. If the line is to go 20 feet in the positive Y direction (up on the screen in plan view), it would be entered as ,20. There is no 0 required for the X component, however the comma is required to designate the 20 is a Y component. The Z component which is 0 may be omitted. If the line were to go 20 feet in the Z direction (up, or toward you in plan view), the coordinate entry would be ,0,20. Again the zeros for the X and Y components are not required, but the comma place holders are. If the line extends diagonally 20 feet in the X direction and 30 feet in the Y direction, the component entry would be 20,30.
Coordinates may be either positive or negative numbers, depending on the direction desired. In plan view, Positive X is to the right on the screen, Positive Y is up on the screen, Negative X is to the left on the screen, Negative Y is down on the screen, Positive Z would extend out from the screen toward you, and Negative Z would extend back into the screen away from you.

The coordinates given will identify a location either globally from absolute 0 in the database, or relatively from the current reference point, depending on the Distance Relative setting. This setting is the second button from the left end of the Status menu. If Distance Relative (REL) is off, coordinates are measured from the database origin, or absolute 0. If Distance Relative (REL) is On, coordinates are measured from the current reference point, which is usually the last point entered. When drawing, it is generally most convenient to have the Distance Relative set to On.

Most of the time coordinate input will be expressed in the same units that the database is currently set for. By default in ARRIS this is feet. Note that many other CAD systems use inches as their default units. Feet and inches are expressed in coordinate input by using the single quote (‘) character for feet and the double quote (”) character for inches. If no unit character is given, the current database unit (by default feet) is assumed.

For example to enter a length of 20 feet six inches, you would input 20’6”. For just six inches you would input 6” since if you were to just put in 6, ARRIS would assume six feet with the default database units set to feet. Note that for coordinate input there is no separator between feet and inches for example 20'-3”. In this example the distance input would be 19 feet 9 inches instead of 20 feet 3 inches because ARRIS sees the dash character as a minus sign and will perform the calculation.

To illustrate coordinate input we will continue to draw lines, this time using coordinate entry at the keyboard. This allows you to draw lines that are an exact known length.

Enter: _lycl <cr>

Prompt: Layer name or number?

Select: The default layer on the Choice menu above the prompt line.

This will erase all of the lines you have just drawn and clear the screen.

Select: The Select button at the top of the Lines Application Sub-menu. This will bring up the Line Select menu.

Select: The property line style on the right side of the Line Select menu. The property line style will highlight. Note that the parameter settings found on the Status menu at the bottom of the screen (including the pen and color) will change to reflect the parameters of the property line style.
Select: The highlighted property line style button again. This will start the Running Line command.

Prompt: **First point of line**

Move the cursor so that the crosshair is in an open area of the screen.

Pick: The point using the left mouse button (F1).

The point will be placed and the cursor will become a rubber band line with one end anchored on the point you just entered and the other end on the crosshair.

Prompt: **Next point of line, (F10 to restart)**

Enter: **100’ <cr>**

The line will be drawn from the first point entered, 100 feet to the right in the positive X direction.

Note that you may need to redisplay the screen to see both ends of the line. To zoom the display to show everything that is drawn, select the **Zoom All** icon on the **View Control Bar**. For a review of all of the screen display commands, see the **View Control Bar** discussion in the **ARRIS User Interface** chapter.

Continue drawing the running line.

Prompt: **Next point of line, (F10 to restart)**

Enter: **60’ <cr>**

The next line segment will be drawn from the end point of the first segment, 60 feet up in the positive Y direction. You may need to Zoom All again to see all of the 2 lines drawn so far.

Prompt: **Next point of line, (F10 to restart)**

Enter: **-50’ <cr>**

The next line segment will be drawn from the end point of the previous segment, 50 feet to the left in the negative X direction.
Prompt: **Next point of line, (F10 to restart)**
Enter: -10'6" <cr>

The next line segment will be drawn from the end point of the previous segment, 10 feet 6 inches down in the negative Y direction.

Prompt: **Next point of line, (F10 to restart)**
Enter: -35'6" <cr>

The next line segment will be drawn from the end point of the previous segment, 35 feet 6 inches to the left in the negative X direction.

Prompt: **Next point of line, (F10 to restart)**
Enter: -12,-10 <cr>

The next line segment will be drawn diagonally from the end point of the previous segment, 12 feet to the left in the negative X direction and 10 feet down in the negative Y direction.

Prompt: **Next point of line, (F10 to restart)**
Pick: The first point of the perimeter you are drawing using the right mouse button (F3).

The next line segment will be drawn from the end point of the previous segment to the first point placed, closing the perimeter.

Prompt: **Next point of line (F10 to restart)**
Press: The F10 key twice to exit the command.

You should now have a drawing that looks like the figure below.
New Reference Point

In many drawing cases a point you are about to input is a known distance from an existing point. In these cases it is very handy to reference the existing point so that the new point is placed accurately. To do this in ARRIS, you reset or move the current Reference Point. The current reference point is indicated by a small white X on the screen. It is usually the last point entered.

To illustrate New Reference Point, we will continue our drawing by adding a building footprint inside the property line. Be sure the Distance Relative mode is set to on. This is shown on the left end of the Status menu under the Rel title. To start, we will change the pen and color.

Select: Pen on the left end of the Status Menu.

Prompt: Pen number (0-15) or none?

Select: 4. The pen box will change to indicate the pen number selected.

Select: Col on the left end of the Status Menu. This will bring up the Color Select Pop-up menu.

Prompt: Color number (0-255) or none?

Select: The bright tan toward the left end of the bottom row of colors on the Color Select Pop-up menu. The color box will change to the color selected.

Select: The Select button at the top of the Lines Application Sub-menu. This will bring up the Line Select menu.

Select: The solid line style on the right side of the Line Select menu. The solid line style will highlight. Note that the parameter settings found on the Status menu at the bottom of the screen will change to reflect the parameters of the solid line style.

Select: The highlighted solid line style button again. This will start the Running Line command.

Prompt: First point of line

Move the cursor so that the crosshair is near the bottom right corner of the property line perimeter on the screen.

Pick: The bottom right corner point using the F9 key on the keyboard.

The Current Reference Point blip will be moved from its previous location (lower left corner) to the point you have just selected. This point is now the current reference point.
When coordinates are entered to input the location of the point **ARRIS** is prompting for, the location will now be calculated relative to the new reference location in the lower right corner of the property line boundary.

**Prompt:** *First point of line*

Enter: `-10,10 <cr>`

The point will be placed 10 feet to the left and 10 feet above the corner of the property line. The cursor will become a rubber band line with one end anchored on the point you just entered and the other end on the crosshair.

**Prompt:** *Next point of line, (F10 to restart)*

Enter: `,-30 <cr>`

The line will be drawn from the first point entered, 30 feet up in the positive Y direction.

**Prompt:** *Next point of line, (F10 to restart)*

Press: The F10 key twice to exit the command.

**Double Reference Point**

The Double Reference Point feature is designed to allow you to precisely locate a point using the cursor, which is aligned with two other points, one in the X direction and one in the Y direction. By using XY Forcing to align the point in either the X or Y direction, which ever is closer, and identifying a second reference point with which the point input is to be aligned in the X or Y direction, which ever is not covered by XY Forcing, the point input is snapped to the crossing of the two alignments.

This feature relies on **XY Forcing** to align the point input in one direction, therefore the **XY Forcing** setting in the lower left corner of the **Status** menu must be set to on.

To illustrate the Double Reference Point feature we will continue drawing the building footprint on our drawing.

**Select:** The **Select** button at the top of the **Lines** Application Sub-menu. This will bring up the **Line Select** menu.

**Select:** The **solid** line style on the right side of the **Line Select** menu. The **solid** line style will highlight. Note that the parameter settings found on the **Status** menu at the bottom of the screen will change to reflect the parameters of the **solid** line style.

**Select:** The highlighted **solid** line style button again. This will start the **Running Line** command.

**Prompt:** *First point of line*

Move the cursor so that the crosshair is near the top end point of the last line you entered in the **New Reference Point** example.

**Pick:** The point using the right mouse button (F3).

**ARRIS** will snap to the existing line endpoint. The F3 key input finds an existing point in the database (see the discussion of Function Keys earlier in this manual). The cursor will become a rubber band line with one end anchored on the point you just selected and the other end on the crosshair.

**Prompt:** *Next point of line (F10 to restart)*

Move the cursor across the screen, stretching the rubber-band cursor line. With the **XY Forcing** setting **On**, the rubber band cursor line will be stretched along the X axis (horizontal).
Press: The **Tab** key on the left side of the keyboard.

When the **Tab** key is pressed, the cursor will lock XY Forcing on the X axis (horizontal). A small white box will appear at the end of the rubber band line cursor indicating that the line is locked in this direction.

Move the cursor near the lower corner of the property line boundary offset as shown in the figure above.

Pick: The lower property line offset point using the right mouse button (F3).

The line will be drawn from the endpoint of the previous line, parallel with the X axis (XY Forcing) to a point which aligns with the point just entered parallel to the Y axis (Double Reference Point).

**Prompt:** **Next point of line (F10 to restart)**

The rubber band cursor will now be anchored on the endpoint of the last line entered. Stretch the cursor line down toward the bottom of the screen.

Press: The **Tab** key on the left side of the keyboard.

When the **Tab** key is pressed, the cursor will lock XY Forcing on the Y axis (Vertical). A small white box will appear at the end of the rubber band line cursor indicating that the line is locked in this direction. Move the crosshair near the beginning point of this series of running lines.

Pick: The beginning point of the line series using the right mouse button (F3).

The line will be drawn from the endpoint of the previous line, parallel with the Y axis (XY Forcing) to a point which aligns with the beginning point just entered parallel to the X axis (Double Reference Point).

**Prompt:** **Next point of line (F10 to restart)**

Pick: The beginning point of the line series using the right mouse button (F3).

The line will be drawn from the endpoint of the previous line to the beginning point just entered.

**Prompt:** **Next point of line, (F10 to restart)**

Press: The **F10** key twice to exit the command.
More Placement and Parameter Information

There are several line placement commands found under the Place heading on the Lines Application Sub-menu. These include Single Line, Running Line, Box, Multiple Lines, Offset Lines, Lines At An Angle To An Existing Line, and many more. At the bottom of the Lines Application Sub-menu is the Tools icon. Selection of this button brings up the Line / Curve Tools menu, where you will find even more options for placing and editing lines. Each of these available functions are described in detail in the Lines topic of the ARRIS Encyclopedia.
When a line parameter style is selected in the Line Select menu, the parameters for the style are set at that time. Selection of the highlighted style button again, or the Place button at the bottom of a Select menu, clears the Select menu from the screen and executes a default placement command. In the case of lines this is the Running Line command. Note that once a line parameter style is selected, the parameters are set so any line placement command may be selected from the Lines Application Sub-menu or Line Tools menu. The Line Select menu will clear from the screen and the placement (or edit) command selected will execute.

The Status menu for lines will show the currently set line parameters at any given point in time. These are the parameters used for a line that is placed at that time. The line parameters may be changed at any time on the Status menu by selecting the box where the parameter is displayed and entering a new value. Because most line commands repeat, this change of parameters may be done “on the fly” while a placement or edit command is still running. The next line segment placed or edited in the placement or edit command will reflect the new parameters set.

<table>
<thead>
<tr>
<th>Line</th>
<th>Width</th>
<th>Close</th>
<th>Mode</th>
<th>Dash 1</th>
<th>Space 1</th>
<th>Dash 2</th>
<th>Space 2</th>
<th>Word</th>
<th>Wordsp</th>
<th>Tx Size</th>
<th>Font</th>
<th>Cen</th>
<th>Pt Size</th>
<th>Pol</th>
<th>Dir</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>off</td>
<td>n/a</td>
<td>normal</td>
<td>0.125</td>
<td>0.125</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>none</td>
<td>0.125</td>
<td>40</td>
<td>cw</td>
</tr>
</tbody>
</table>

Drawing Exercise

On the next page is a sample exercise to use what you have learned so far. The exercise may be completed using only the three line parameter styles you created in the Parameters chapter of this guide. These line parameter styles may also be found in the ARRIS Entity Styles catalog which comes with ARRIS out of the box. The exercise may be completed using only the basic line commands as shown in the previous examples in this chapter, however you may wish to try a few of the other line placement commands found under the Place heading on the Lines Application Sub-menu and on the Line / Curve Tools menu.

This exercise is to use the various line commands to draw the property line, house, driveway, and sidewalks. The dimensions are shown only to aid you in locating and sizing the house, walks, and property lines. Drawing dimensions will be covered in another tutorial.

To make your drawing have more depth, try varying the pen weights and colors for the various things you are drawing as you draw. Don’t worry about layers or saving your work yet. The discussion of layers and saving are found later in this tutorial.

If you make a mistake, you can easily correct it using the Undo button. This will remove the last thing entered or undo the last edit. The Undo button is found in the middle of the Desktop menu at the top of the screen.

Have Fun!
7. Editing In ARRIS

In this chapter we will discuss the basic editing tools in ARRIS. The Edit pull-down menu is accessed by selecting the Edit icon on the Main menu.

The Edit Menu

There are 3 steps to setting up an edit on the Edit pull down menu. They are logically ordered and labeled on the menu.

1. The first step in the edit process is to select the entity type(s) to be edited, and any filters.

2. The second step in the edit process is to select the desired method of searching the database for the selected entity.

3. The third step in the edit process is to select the Edit Action.

You can filter the entities in the selection to include only those of a particular pen or color. When a single entity type is selected, you can also filter by entity property. The “C” button clears all.

The currently selected entity type is displayed here.

The currently selected search method is displayed here.

Hilite Mode: When on, selected entities will be highlighted in white on the screen.

Drag Mode: When on, selected entities will be dragged with the cursor during moves.

Special edit functions are available, depending on the Entity Filter selected. These special edits are specific to the selected

The first step is to select the Entity Filter. An edit may include any and all entities or it may be limited to a particular entity type, for example lines. The edit may be further limited or filtered to an entity of a particular pen or color, or to one that has a specific entity property.

The second step is to select the Search Method. This determines how ARRIS will search the current drawing for the entity type(s) you have selected for the edit. Search methods include a single entity, all within an area, all outside of an area, the entire drawing, or entities selected in a group.

The third step is to select the Edit Action to be performed. These include Delete, Freeze, Move, Move Relative, Stretch, Stretch Relative, and Move Scale / Rotate. This step may also change either All or Some of the specific properties of the selected entity, as well as the general properties of Layer, Pen, and Color.

The Some option displays a menu of the entity properties of the specific entity selected to choose from for the edit and both the current entity property value and current parameter setting value. Special entity specific edits are also available and will vary depending on the Entity Filter selected. Other parameters useful for editing found on the Edit pull-down menu include the Entity Filter Properties, Drag, and Hilite.

The specific functions of the buttons under the Entity Filter, Search Method, and Edit Actions headings on the Edit menu are shown in more detail later in this chapter.
Move Everything In An Area

To illustrate the edit process, we will edit the small site plan drawing created in the Drawing In ARRIS chapter.

Select: The Edit icon on the Main menu to display the Edit pull-down menu.

Select: The Any Entity button under the Entity Filter heading at the top of the Edit menu. The button will highlight and ANY ENTITY will display as the selected entity type in the box next to the Entity Filter heading.

With the Any Entity entity filter, when the edit is executed, ARRIS will not limit the edit to a specific entity type. All entities which meet the search method criteria will be considered a part of the edit.

Select: The Area In button under the Search Method heading in the middle of the Edit menu. The Area In button is the third button from the left in the top row of Search Method buttons. The button will highlight and Area In will display as the selected search method in the box next to the Search Method heading.

With the Area In search method, when the edit is executed, ARRIS will prompt for you to define an area or fence. All entities completely within this area will be considered a part of the edit.

Select: The Move button under the Edit Action heading in the lower part of the Edit menu. The Move button is the left most button in the bottom row of Edit Action buttons.

Prompt: 1st fence point for move (F10: options):

Move the crosshair to a position below and to the left of the house.

Pick: A point below and to the left of the house using the left mouse button (F1 key).

The cursor will be come a rubber-band box anchored on the first point you have just selected.

Prompt: 2nd fence point for move:

Move the crosshair, stretching the rubber-band box to a point above and to the right of the house.
Pick: A point above and to the right of the house using the left mouse button (F1 key).

The edit fence will be shown on the screen and all entities which meet the Entity filter and Search Method criteria will be highlighted. In our example, all entities (in our case there are just lines) which have both endpoints within the area defined will be highlighted.

Prompt: **Reference point for move (F10: current ref):**

Move the crosshair to a point on the lower left corner of the house.

Pick: The lower left corner of the house using the right mouse button (F3).

The cursor will change to a ghost image of the entities which are to be moved. This is to aid in placing them manually. The reference point you have just picked will be used to relocate the entities being moved.

Prompt: **New location (F10: reselect):**

The current reference point is located on the point you selected in the previous prompt. **ARRIS** is now prompting for the new location of that specific point. If the Distance Relative mode is On, and coordinates are input, this new location will be relative to the current reference point, or old location of the point. All entities which are selected and highlighted will be moved the same relative distance.

Enter: ,12' <cr>

All entities highlighted for the move will be moved 12 feet up in the positive Y direction.

Prompt: **1st fence point for move (F10: options):**

Press: The **Escape [Esc]** key to exit the command.

The move command repeats, prompting for another area to move, so pressing the Escape key ends the command. Your drawing will now look something like the figure to the right.

Notice that the lines which did not have both ends of the line inside the fence were not changed. They were not included in the search window because by definition **Area In** requires both endpoints of the line to be in the search window for the line to be included. The menu Edit commands look at the entities, not the individual points, to move. The lines of the driveway and sidewalk which no longer reach the house may be edited to do so using the Stretch command.

Select: The **Undo** button on the **Main** menu to undo the move.

Try the edit again, only this time instead of selecting the Move button for the edit action, select the Stretch button instead. The lines which are completely within the fence will be moved in their entirety. The lines which have only one endpoint in the fenced area will be stretched, with the point inside the fence moving and the point outside the fence remaining in place.
Entity Filters

Entity Filters are used on the Edit and Copy menus to limit the edit or copy to a specific entity type. This makes it easy in ARRIS to select the exact entities on which you will perform an edit (or copy). The specific filtering function of each of the Entity Filter buttons on the Edit (and Copy) menu is shown below.

For more information on Entity Filters, refer to the Entity Filter, Edit, and Copy topics in the ARRIS Encyclopedia.
Search Methods

Search Methods are used on the **Edit** and **Copy** menus to limit the edit or copy to a specific area of the database or group of entities. This makes it easy in **ARRIS** to select the exact entities on which you will perform an edit (or copy). The specific search function of each of the Search Methods buttons on the **Edit** (and Copy) menu is shown below.

For more information on Search Methods, refer to the **Search Method**, **Edit**, and **Copy** topics in the **ARRIS** Encyclopedia.
**Edit Actions**

*Edit Actions* are the actual edit performed on the entities as selected using the Entity Filter and Search Method. Edits include Delete, Moves, Stretches, Layer Change, and changing of either Some or All Parameters. The functions of each of the *Edit Action* buttons found on the *Edit* menu are shown below.

For more information on *Edit Functions*, refer to the *Edit Actions* topic in the *ARRIS Encyclopedia*.

Edits may also be done using the *Select Entity* feature. In this process, with no other command running, the entity is selected first either by single or area selection. The edit action is then selected from the *Select Entity* menu which pops up.

The edit icons found on the *Select Entity* menu correspond in function to those found on the *Edit* menu. The Scale and Rotation factors for Scale/Rotate Moves and Copies may also be set and cleared on the *Select Entity* menu.

For more information, refer to the *Select Entity* discussion in the *ARRIS User Interface* chapter of this tutorial, and to the *Select Entity* topic in the *ARRIS Encyclopedia*. 
8. Basic Entity Parameters & Commands

Lines

The parameters used to draw Lines are illustrated in the Line/Curve Create menu below.

Dash Parameters:
Determines the plotted length of dashes and spaces in Dashed line types.

Word Parameters:
Determines the text and text parameters used in Word line

Line Type:
The current line type is highlighted. Each type has a number which is indicated in the Line box.

Dashed Line, Dash1, Space1, Dash2, Space2 pattern.

Dashed Line, Dash1, Space1, Dash2, Space2, Dash2, Space2 pattern.

Double Line types:
Two solid outside lines with dashed centerline.

Double Line types:
Two solid outside lines with dashed centerline.

Mode:
Determines the start and ending pattern for Dashed line

Closure:
Determines the line end closure condition for double

The most common placement commands used to draw Lines are illustrated in the Lines Application Sub-menu menu below.

Running
Single Line
Multiple Lines
Offset Line
Parallel Line
Trim &
Insert Point in a Chamfer Corner

More line placement commands may be found on the Line/Curve Tools menu.

For a complete documentation of line parameters and line placement commands, refer to the Lines topic in the ARRIS Encyclopedia.
Basic Entity Parameters & Commands

Circles / Arcs

Circles and Arcs in **ARRIS** are drawn using the same parameters as lines. There are a few additional parameters unique to circles. The parameters used to draw **Circles** and **Arcs** are illustrated in the **Line/Curve Create** menu below.

**Line Type:**
The current line type is highlighted. Each type has a number which is indicated in the **Line** box.

The line types and dash parameters for the line which comprises a circle or arc are the same as those used to draw 

**Point Size:**
Sets the size of the symbol (in inches when plotted) for a circle/arc center.

**Center Point:**
Sets the symbol to be displayed at the center of a circle or

The most common placement commands used to draw **Circles** are illustrated in the **Circles** Application Sub-menu menu below.

2 Point Circle (Diameter points)
2 Point Circle (Center-Diameter)
2 Point Semi-Circle
2 Point Arc (Center, Radius, Sweep Angle)
3 Point Arc (Radius Points)
Full Ellipse
Trim/Extend Arc
Break Circle/Arc

**Polygon Sides:**
Determines number of equal sides for a polygon.

**Arc Direction:**
Determines direction an arc is drawn, either clockwise or counter-clockwise.

**For a complete documentation of line/circle parameters and Circle / Arc placement commands, refer to the Circles topic in the **ARRIS** Encyclopedia.**
The parameters used to place basic Text are illustrated in the **Text Create** menu below.

- **Text Font:** The font file which determines the look of the text. Available text fonts are listed, loaded text fonts are highlighted.
- **Text Justification:** The location of the database point relative to the string of text.
- **Text Size:** The height of the text in inches when displayed.
- **Text Spacing:** The spacing between multiple lines of text expressed as a multiple of the text height.
- **Text Underline:** When on, the text is underlined.
- **Any TrueType font on your computer may be translated into a .lt font file for use in Text Font:** The current font is displayed here. A sample of the font is shown in the Sample window.
- **Text Slant:** Sets the degree of slant of the text characters.
- **Text Rotation:** Sets the degree of rotation of the text. Rotation of 0 is horizontal.
- **Display:** Displays fonts which have a solid fill in either Solid or Outline mode.
- **Box Text:** Displays the text as a simple rectangle when the height of the text is below the set pixels at the current zoom factor.

The most common placement commands used place basic Text and the Text String Edits are shown on the **Text Application Sub-menu** menu below.

- **Paragraph Text with leader**
- **Single Text**
- **Multiple Text**
- **Change all text in an area.**
- **Change Single**
- **Edit Paragraph**
- **More text placement commands may be found on the Text Tools menu.**

For a complete documentation of text parameters and text placement commands, refer to the **Text** topic in the **ARRIS Encyclopedia**.
Basic Entity Parameters & Commands

Dimensions

Dimensions in ARIS have separate parameters for the various parts of the dimension. The Witness Lines use similar parameters to lines. The Dimension Text uses similar parameters to text. The parameters used to draw Dimensions are illustrated in the Dimension Create menu below.

- **Dimension Line Location**: Locates the Dimension Line inside or outside the Witness Line.
- **Dimension Line Scale**: Sets a scale factor relative to the database.
- **Witness Line Mode**: Sets witness lines to automatic, fixed (distance) or none.
- **Witness Line Offset**: Offset from the point being dimensioned in inches when plotted.
- **Dimension Mark Type**: Symbol table number for the symbol used at the intersection of the dimension line and witness line.
- **Dimension Text Mode**: Sets the dimension to automatic (associative) or manual (user).
- **Dimension Orientation**: Sets the dimension line and text to horizontal, vertical, or parallel to the dimensioned points.
- **Dimension Text Parameters**: Text parameters for dimension text are similar to those for text.

The most common placement commands used to draw Dimensions are illustrated in the Dimensions Application Sub-menu menu below.

For a complete documentation of dimension parameters and placement commands, refer to the Dimensions topic in the ARIS Encyclopedia.
Patterns

Patterns consist of 3 types. They may be composed of Lines, Repeated Items, or a Solid Fill. The parameters used to place line Patterns are illustrated in the Pattern Create menu below.

Pattern Type:
May be either Line, Repeated Item, or Solid Fill.

Boundary Line:
The boundary line of the pattern area may be either visible (Retain) or not visible.

Line Pattern Units:
Line pattern parameters may be expressed in either Paper or Geometry.

Line Pattern Type & Dash Parameters:
Line types and dash parameters for pattern lines are similar to those used for regular.

Repeated Item Patterns:
RI Patterns have the RI parameters of Name, Scale, and Rotation used in the

Line Pattern Offset:
The offset to the first line in the pattern.

Line Pattern Rotation:
The rotation of the lines in the pattern.

Line Pattern Space:
The spacing between lines in the pattern.

Line Pattern Line:
The number and individual types of line in the pattern.

The most common placement commands used place Patterns are shown on the Patterns Application Sub-menu menu below.

Running Line Boundary:
Define a pattern boundary point to point using a running line.

Boundary Chase:
Define a pattern boundary by chasing existing connected lines.

Boundary Chase Area:
Define a pattern boundary by including an existing closed series of lines in a fence.

Fill:
End the boundary definition and fill the defined boundary.

Rectangular Boundary:
Define a pattern boundary using a two point rectangle.

Circular Boundary:
Define a pattern boundary using a two

Zone Boundary:
Define a pattern boundary using an

Cancel:
Cancel a boundary definition and remove any boundary lines placed thus far for the specific pattern.

For a complete documentation of crosshatch patterns and pattern placement commands, refer to the Patterns topic in the ARRIS Encyclopedia.
Basic Entity Parameters & Commands

Repeated Items

Repeated Items are unique entities in ARRIS. They consist of other entities which are grouped together, given a name, and stored in a library. The parameters used to place Repeated Items are illustrated in the Repeated Items Status menu below.

<table>
<thead>
<tr>
<th>Repeated Item Library</th>
<th>Repeated Item Name</th>
<th>RI Scale(s)</th>
<th>RI Rotation(s)</th>
<th>Offset</th>
<th>Drag</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D util_j_arris.ri</td>
<td>j_xeiltins</td>
<td>XYZ 1.000</td>
<td>XYZ 0.000</td>
<td>0,0,0</td>
<td></td>
</tr>
</tbody>
</table>

Repeated Item Library: The library from which the RI is to be repeated.

Repeated Item Name: The name of the specific Repeated Item to be placed.

Repeated Item Scale: The scale of the placed RI relative to the original. The scale is given as a multiplier (factor), and may be broken up into individual X, Y, and Z axis (relative to the original) components.

Repeated Item Rotation: The rotation of the placed RI relative to the original. The rotation is given in degrees, and may be broken up into individual X, Y, and Z axis (relative to the original) components.

Repeated Item Offsets: The Repeated Item may be placed with X, Y, and Z offsets from the original.

Repeated Item Drag: During placement with drag set to On, the cursor will take the shape of the selected RI allowing better visual location.

The most common placement commands used to place Repeated Items are illustrated in the Repeated Item Application Sub-menu menu below.

For a complete documentation of Repeated Item parameters and placement commands, refer to the Repeated Items topic in the ARRIS Encyclopedia.
Raster Entity

The Raster Entity feature allows you to place a reference to a supported raster file in your database. The raster image will be displayed in your ARRIS drawing. The parameters used to place a Raster Entity are illustrated in the Raster Status menu below.

Raster Image File:
The file name of the raster image file which is to be placed on the drawing. Supported file types are .jpg, .bmp, .tif, .png, .gif, .sc (ARRIS), .rs, and .tga.

Pre-Rotation:
The image is normally placed in the same orientation as it is stored in the file. This parameter allows you to place the image rotated in 90 degree increments.

Inversion:
The image is normally placed in the same colors as it is stored in the file. This parameter allows you to invert the colors of the image making it look much like a film negative. Inversion may be set for screen display only, plotting only, both screen display and plotting.

Raster Images are placed using the two point linear method. This is much like drawing a line. ARRIS will prompt for the first point (lower left corner) and then second point (lower right corner). The line defined by these two points is the bottom edge of the Raster Image. The image is placed with the original proportions from the image file, and is scaled based on the two points input.

For a complete documentation of Raster Entity parameters and placement commands, refer to the Raster Entity topic in the ARRIS Encyclopedia.
Basic Entity Parameters & Commands

Surfaces

The parameters used to model Surfaces are illustrated in the 3D Construction Setup menu below.

Solid Closure: Include this surface in a parametric solid.

Intensity: The intensity of the color. The intensity is given in a range from 0 (black) to 1000 (brightest).

One Sided Triangle: Make the surface single sided only. This is used by many rendering programs to reduce the calculations needed and speed the rendering process.

Phong Shading: Allows curved surfaces to be rendered smooth with fewer segments.

Solid Color / Pen: The pen and color to be used

Translucency: The percentage of transparency of the surface.

Surface Name: Each surface in a parametric object may be given a name to identify

Shadow: Surfaces cast shadows.

Surfaces may be placed individually or parametrically as part of a larger object. Note that parametric objects are placed as a series of surfaces, not a solid object. The most common placement commands used to place Surfaces are illustrated in the Solids and Slab & Path Application Sub-menus shown below.

For a complete documentation of Surface parameters and placement commands, refer to the Surfaces and Slabs topics in the ARRIS Encyclopedia.
9. Data Files

Projects

**ARRIS** provides a logical system for data organization which makes your drawings easy to manage, locate, and use. At the top level of this organization is the Project. The project is a directory or folder on your computer which contains all of the databases, drawings, sheets, layers, and other files related to a single building project. The default filename extension for project directories is `.pj`.

While all of the **ARRIS** data for a given architectural project will be stored in various sub-directories under a project directory, there is no reason why other non-**ARRIS** data may be stored under the same project directory. For example outside of **ARRIS** you may create a sub-directory under the project for specifications, or for correspondence. Using the project directory in this way ensures that all data relating to a given project, regardless of the type of data or software used to create it, will be stored in the same

We will now create a sample project directory on your computer.

Select: The File icon on the Desktop menu. This will bring up the File pull-down menu.

Select: New on the File Pull-down menu. This will bring up the New pop-up menu.

Select: Project on the New Pop-up menu. This will bring up the Create New Project pop-up menu.

Select: Empty Project on the Create New Project Pop-up menu.

Select: OK on the Create New Project Pop-up menu. The Create New Project Pop-up menu will change to display more project information.

Select: The Blank box under the Number heading on the Create New Project Pop-up menu.

Prompt: *Project number for new project.*

Enter: `200401 <cr>`.

Select: The box under the Name heading on the Create New Project Pop-up menu.

Prompt: *Project name for new project.*

Enter: `Tutorial Project <cr>`.

Select: OK on the Create New Project menu.

Prompt: *New project directory name.* **ARRIS** is asking for the path name to the new project directory. Note that the project directory itself does not have to exist, however all directories in the path above the project must exist.

Enter: `C:\arris_users/200401.pj <cr>`.

The new project directory `200401.pj` will be created on your computer under the `C:\arris_users` directory. For more information, refer to the Projects, Project Directory, and Project List Manager topics in the **ARRIS** Encyclopedia.
Data Files

Databases

A **ARRIS** Database is a directory which contains related drawing information within a project. The filename extension for a Database is `.db`. Files included within a database include layers, drawings, sheets, and a variety of other information used in a graphic drawing. **ARRIS** must always have a database loaded. On startup a default database `noname.db` is loaded from the current project, standards, or user home directory.

The project directory, which corresponds to the building project in your office, such as a home or small commercial building may contain one or more databases.

Databases may be used to organize your graphic data within a project. For example, a database may contain all floor plan information, elevations, sections, or details. Databases may also be organized to contain all graphics in the project drawn at a particular scale.

To create a new database on your system:

Select: The **File** icon on the **Desktop** menu. This will bring up the **File** pull-down menu.

Select: **New** on the **File** Pull-down menu. This will bring up the **New** pop-up menu.

Select: **Database** on the **New** Pop-up menu. This will bring up the **Create New Database** pop-up menu.

Select: **Empty Database** under the **Template For New Database** heading on the **Create New Database** Pop-up menu.

Select: **OK** on the **Create New Database** Pop-up menu.

Prompt: **Unload active drawing?**

Select: **yes**

Prompt: **New database name?**

Select: **MENU**. This brings up the **ARRIS** browse menu which allows you to browse through your computer file system to the project directory where you want the database to be created. The Place In directory shows the current directory where the database will be created. Browse to the new project directory that you have created `C:\arris_users\200401.pj`.

Select: The box next to the **New Name** heading.

Prompt: **Database name?**

Enter: `tutorial.db <cr>`

Select: **OK** on the **Name For New Database** browse menu.

The new database will be created and **ARRIS** will load it to become the current database. After the database is loaded, the **Database Format** pop-up menu will appear. This menu allows you to set general format parameters for the database including the units (feet by default), and scale.

For more information, refer to the **Database** topic in the **ARRIS** Encyclopedia.
Layers

A layer is a subdivision of a drawing which contains graphic information. Several layers together are combined to make up a drawing. ARRIS is unique in that each layer is an individual file on your computer. The layer file is found within the database directory. Its file name on your computer corresponds to the layer name within ARRIS and has a .ly extension. Each database may have up to 1,000,000 layers.

The layer’s read/write permissions may be controlled individually for each layer in each drawing. ARRIS will also track when and where a layer is loaded and allow write permissions to only one person at a time.

Layers are created by selecting New on the Layer Pop-up Menu. More information on layer properties and functions may be found in the ARRIS Encyclopedia in the Layer topic.

Drawings

A Drawing in ARRIS is simply a collection of layers. When a drawing is opened, all layer files defined or listed as a part of that drawing are opened. The Drawing Register file on the computer is a simple text file inside the database directory which contains a list of layers to be included in the drawing as well as other data specific to that drawing. It’s filename extension is .dr.

Each database contains at least 1 drawing which is named master.dr. There is no limit to the number of drawings which may be created and used within a database.

Layers are generally used to separate different types of graphic information within the drawing, for example walls are placed on one layer and dimensions on another. A layer may belong to any number of drawings. It is this concept which makes ARRIS so flexible and easy in accessing and sharing information. For example, a layer which contains floor plan walls may belong to a floor plan drawing. It may also belong to an electrical plan drawing. If a change is made to the plan on this layer while in the floor plan drawing, the electrical plan drawing is updated at the same time because it contains the same layer.

For more information on Drawings, refer to the Drawings, Drawing Manager, and Drawing Register File topics in the ARRIS Encyclopedia.
Data Files

Sheets

A Sheet is a special type of drawing. Like a drawing, it is a collection of layers. It is primarily a composition tool for plotting and can be used as a navigation tool to specific drawn information. Each sheet represents a plotted sheet in the drawing set.

A Sheet consists of only 2 layers, one for a project border and title block shared among all sheets in the drawing, and the other for sheet specific text and graphics and drawing data placed in the form of viewports. A sheet is always full scale and is limited to 2D graphics.


For more information, refer to the Sheet, Sheet Register File, and Sheet Space topics in the ARRIS Encyclopedia.

Viewports

A Viewport is a basic ARRIS entity which functions as a portable window on a 2 dimensional Sheet, which views into a 3 dimensional Drawing. A viewport is similar to a drawing in that it is a collection of layers. It is identified by a name and origin point and carries the additional properties of boundary, orientation, scale, rotation, and opacity.

A Viewport is created by defining it while in a drawing. Select the Viewport icon on the Main menu. Next select Name and fill in a name, and select the sizing method of either Fixed or Dynamic. Next select OK and define the viewport boundary.

While in a Sheet, a defined viewport may be placed by selecting the Viewport icon on the Main menu. Next select Place File under the Place heading of the Viewport Layout menu, then select the database where the viewport was cut and the viewport from the Viewport Select menu. Place the viewport on the Sheet.

For more information, refer to the Viewport topic in the ARRIS Encyclopedia.
10. More Things To Know

The Object Snap Menu

The ARRIS Object Snap menu allows you to snap to locations on existing objects in the database. These settings will allow you to find locations on objects that are not ordinarily found using the Function Keys, such as a tangent point on a circle, or the center point of a line, or a point where 2 lines would intersect if they were extended. Some Object Snap menu functions are duplicates of those which may be found using Function Keys, such as finding a Database Point, finding a Display List Point, or finding the intersection of two lines.

The ARRIS Object Snap menu is called up by selecting the Object Snap icon on the Main menu.

Any time an ARRIS command is prompting for a point input, you may specify one of the Object Snap functions by selecting the Object Snap icon on the Main menu, then selecting the specific function desired. For example if the ARRIS line command is prompting for the first point of a line, and you want the new line to begin at the midpoint of an existing line, at the First Point prompt, select the icon on the menu to pull down the menu. Next select the icon under the heading on the menu. The menu will clear from the screen. Pick the existing line whose midpoint is to be the beginning of the new line. The point will be located at the midpoint of the selected line.

The Object Snap menu is divided into 2 parts, Single and Continuous. When an icon is selected under the Single heading, the Object Snap function will be in effect for the next single point input only. If the function is selected under the Continuous heading, it will be in effect until cleared. If an Object Snap is in effect, the Object Snap icon on the Main menu will remain highlighted. A Continuous Object Snap function may be cleared by a right-click selection on the highlighted Object Snap icon on the Main menu.

For more information, refer to the Object Snap topic in the ARRIS Encyclopedia.
More Things To Know

The Layer Menu

ARRIS has a lot of flexibility in manipulating layers. Each layer is identified by a number, a layer name, and has a plain text description to help identify the information contained within it. Layers may be individually set to one of 3 different modes of On, as well as turned Off. The Layer Modes menu is accessed by selecting the Layer button on the Main menu.

Layer Number - Represents the ARRIS internal identification number. Selecting the number changes the layer number for the layer in the specified row.

Layer Name - Shows the layer name, which is also the layer’s file name on the disk. Selecting the name changes the layer name for the layer in the specified row.

Layer Description - Displays a description of the layer. Selecting the description changes the layer description for the layer in the specified row.

Entity Count - Shows the number of entities contained in the given layer.

Layer Modes - The layer modes determine the “On” status of the layer. Layers may be on for Display, Search, and Edit. Layer Modes are detailed further on the next page.

Layer Modes menu:

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Description</th>
<th>Entities</th>
<th>Modes</th>
<th>Perms</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>common</td>
<td>Common Layer</td>
<td>0</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>1</td>
<td>border</td>
<td>Border &amp; Title Block</td>
<td>346</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>2</td>
<td>page</td>
<td>Page Graphics - A1</td>
<td>14</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>11</td>
<td>a01pch</td>
<td>Plan 1 Poche</td>
<td>4802</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>12</td>
<td>a01wal</td>
<td>Plan 1 Walls</td>
<td>783</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>13</td>
<td>a01fix</td>
<td>Plan 1 Fixtures</td>
<td>30</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>14</td>
<td>a01plan</td>
<td>Plan 1 Plan</td>
<td>44</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>15</td>
<td>a01dim</td>
<td>Plan 1 Dimensions</td>
<td>876</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>16</td>
<td>a01key</td>
<td>Plan 1 Keys</td>
<td>142</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>17</td>
<td>a01not</td>
<td>Plan 1 Notes</td>
<td>45</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>18</td>
<td>a01rmn</td>
<td>Plan 1 Room Names &amp; No.s</td>
<td>97</td>
<td>WK</td>
<td>S</td>
</tr>
<tr>
<td>19</td>
<td>a01grid</td>
<td>Plan 1 Structural Grid</td>
<td>17</td>
<td>WK</td>
<td>S</td>
</tr>
</tbody>
</table>

Styles - The current layer modes may be saved by name as a style for later recall. The functions which open, save, and delete layer styles are found under the Styles menu.

Management - Contains functions which allow you to manage layers in the current drawing. Portions of the Layer menu will change depending on the

Properties - Contains functions which allow you to manage the properties of layers in the current drawing. Portions of the Layer Menu will change depending on the function

PERMS - This field shows the permissions of the layer for the current drawing. The layer may be either Read & Write (RW), Read Only (RO), or Temporary (TEMP).
Layer Modes are an important feature in ARRIS. The layer modes allow a great amount of flexibility, particularly in edits. If the Edit mode on a layer is not on, entities on that layer will not be edited, even if they otherwise meet the Entity Filter and Search Method criteria on the Edit menu for an edit. Refer to the chapter on Editing in ARRIS. If the layer Search mode is on, the entities on the layer may be “searched”. This means that data points for the entity will be found by a function key selection, therefore they may be used as reference points. It also means that the entity may be copied. If the Display Mode is on, entities are displayed on the screen. What you can do with entities on the layer depends on the Search and Edit mode settings, not whether or not the data is visible on the screen.

Layer Modes have a hierarchy. If a the Edit mode is turned on, the Search and Display modes are also turned on, regardless of the previous status. If a layer is editable, it must also be searchable and displayable. If the Search mode is turned on, the Display mode will also be turned on. If the layer is searchable, it must be displayable (but not necessarily editable).

The Work layer is the layer onto which all new data is placed. There may only be one work layer at a time, and there must be a layer designated as the work layer at any given time. The work layer must be editable, therefore when a work layer is selected, the Edit, Search, and Display modes are all turned on for that layer.

The proper use of Layers and Layer Modes is a very powerful tool in ARRIS. The combination of Layer modes and the Entity Filters and Search Methods in the Edit menu allow a high level of precision in isolating specific entities for editing.

Because each layer is its own individual file in ARRIS, there is a huge amount of flexibility in composing drawings. Layers may belong to more than one drawing, allowing shared information such as walls shared between architectural, mechanical, and electrical floor plans. It also allows you to load only the layers you need. This makes everything including loads, saves, displays, searches, and manipulation of data much faster.

More on the concept of layers and the Layer as a file type may be found in the Data Files chapter of this manual. For a detailed discussion of all functions of the Layer menu refer to the Layer topic in the ARRIS Encyclopedia.
More Things To Know

Copies

In ARRIS, copies are very similar to Edits. The Copy menu looks very similar to the Edit menu, and works the same way. The Copy menu may be found by selecting the Copy icon on the Main menu.

Like edits, there are 3 steps to setting up a copy on the Copy pull down menu. They are logically ordered and labeled on the menu.

1. The first step in the copy process is to select the entity type(s) to be copied, and any filters.

2. The second step in the copy process is to select the desired method of searching the database for the selected entity.

3. The third step in the copy process is to select the Copy Action command desired.

You can filter the entities in the selection to include only those of a particular pen or color. When a single entity type is selected, you can also filter by entity property. The “C” button clears all filters.

The first step is to select the Entity Filter. A copy may include any and all entities or it may be limited to a particular entity type, for example lines. The copy may be further limited or filtered to an entity of a particular pen or color, or to one that has a specific entity property. Refer to the Entity Filter discussion in the Editing In ARRIS chapter of this tutorial.

The second step is to select the Search Method. This determines how ARRIS will search the current drawing for the entity type(s) you have selected for the copy. Search methods include a single entity, all within an area, all outside of an area, the entire drawing, or entities selected in a group. Refer to the Search Methods discussion in the Editing In ARRIS chapter of this tutorial.

The third step is to select the Copy Action to be performed. These include a Single Copy, Multiple Copies in a Grid, Copy Mirror around the X or Y or both axes, Copy with a change of Scale or Rotation, and Copy in a Circular Array. You can also copy to the ARRIS clipboard for pasting in other ARRIS drawings or even ARRIS sessions.

The current Scale, Rotation, and Rotation Direction are shown and may be set here. These settings are used in the Copy Scale / Rotate command.

Layer Retain: When on, entities are copied to the same layer as the original instead of the current layer.
Other useful copy parameters found on the Copy Pull-down menu include Layer Retain, Drag, and Hilite as well as the Scale, Rotation, and Direction parameters used in Scale / Rotate copies.

Data which is contained in a different database/drawing may also be copied into the current drawing. This may be done by specifying a layer, drawing, viewport, or entire database to be copied on the Copy menu.

The specific Copy Actions for each button on the Copy menu are shown below.

For more information refer to the Copy Actions topic in the ARRIS Encyclopedia.

Copies may also be done using the Select Entity feature. In this process, with no other command running, the entity is selected first either by single or area selection. The copy action is then selected from the Select Entity menu which pops up.

The copy icons found on the Select Entity menu correspond in function to those found on the Copy menu. The Scale and Rotation factors for Scale/Rotate Moves and Copies may also be set and cleared on the Select Entity menu.

For more information, refer to the Select Entity discussion in the ARRIS User Interface chapter of this tutorial, and to the Select Entity topic in the ARRIS Encyclopedia.
More Things To Know

Saving Your Work

As you work, ARRIS keeps track of new and changed information in the active memory of your computer. In order for these changes to be made permanent, you must save your data to the hard drive. This is done with the Save command.

The ARRIS Save functions are found on the Save pull-down menu. To access this menu, select the Save icon on the Main menu. There are several functions on the Save pull-down menu. For this tutorial, we will be concerned with just two - Save and Save As New Database.

When Save is selected on the Save pull-down menu, ARRIS will prompt to verify the save. Select yes at the verify options prompt. All updated data will be written to the disk, and the drawing file will be updated with the current layer information. The quick option at the save verify prompt will perform a quick save. With this option only the layers that have changed are written, and the drawing data is not updated. If you have added or deleted layers it is very important to do a full save so that this information is saved properly.

The Save As New Database button will allow you to save the data contained in the currently loaded database to the disk as a new database with a different name. The old database will contain the data as it was at the last normal save. When the Save As New Database function is executed, ARRIS will prompt for which layers to include in the new database. Your choices are all layers that were in the old database, only the layers in the current drawing, and only the displayable layers. ARRIS will next prompt for the new database name. The new database will become the currently loaded database.

Many ARRIS users find it convenient to save their work using the save mnemonic command. This command is typed at the keyboard. ARRIS will prompt to verify the save. You can invoke the mnemonic command and answer the verify prompt all in one step by adding a semi-color (;) between the command and the prompt answer. The syntax for this is:

\texttt{save;y <cr>}

The save command will be executed.

It is very important to remember to save your work often. Every 15 to 20 minutes, or when ever you change the work layer to work on a different part of the drawing is a good rule of thumb. Obviously you should save your work before leaving the current database by loading a new database or by exiting ARRIS.

ARRIS contains an autosave feature which makes a duplicate copy on the disk of the layers in active memory when the database is loaded, and then updates these copies at a specified time interval. The autosave files are removed when the database is unloaded. The autosave interval is set on the ARRIS Preferences menu, and has a default setting of 10 minutes. Because the autosave time is not reset when the database is saved, the autosave copy may or may not be more recent than the actual layers saved to the disk. When the database is loaded after an abnormal exit, and the autosave files still exist on the disk, ARRIS will prompt to recover from the autosave files. Note that this feature is designed as an emergency fail-safe only. It is not designed to replace good habits in saving your work.